Biblio-Link II

Windows 2000/98/95/NT4
and
Power Macintosh

ISI ResearchSoft
© 1999 Institute for Scientific Information
Copyright Notice

This software product and accompanying documentation are copyrighted and all rights reserved by Institute for Scientific Information. Please refer to the accompanying End User License Agreement for a specification of the terms and conditions governing the use of this product.

Disclaimer of Warranty

This software and manual are sold "as is" and without warranties as to performance or merchantability. The seller's salespersons may have made statements about this software. Any such statements do not constitute warranties and shall not be relied on by the buyer in deciding whether to purchase this program.

This program is sold without any express or implied warranties. Because of the diversity of conditions and hardware under which this program may be used, no warranty of fitness for a particular purpose is offered. The user is advised to test the program thoroughly before relying on it, and must assume the entire risk of using the program. Any liability of seller or manufacturer will be limited exclusively to product replacement or refund of the purchase price. In no event shall ISI ResearchSoft, or anyone else who has been involved in the creation and production of this computer software be liable for indirect, special or consequential damages, such as but not limited to, loss of anticipated profits or benefits resulting from the use of this program. Some states do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation may not apply.

Trademarks

ProCite and Biblio-Link are registered trademarks of Institute for Scientific Information. Cite while you write is a trademark of Institute for Scientific Information. Microsoft and Windows are registered trademarks of Microsoft Corporation. Apple, Macintosh, and Power Macintosh are registered trademarks of Apple Computer, Inc. Corel and WordPerfect are registered trademarks of Corel Corporation. All other brand and product names are trademarks or registered trademarks of their respective companies.
# Contents

## Chapter 1: Introduction and Installation
- Biblio-Link II ................................................................. 7
- Downloading Information ........................................... 7
- Troubleshooting .......................................................... 8
  - Help Online ........................................................... 8
  - Technical Support .................................................. 9
- Using This Manual ..................................................... 10
- Installation ................................................................. 10

## Chapter 2: Getting Started: A Guided Tour
- Overview ................................................................. 11
- Examining the Downloaded Records .......................... 11
- Creating the Configuration File ................................. 13
- Identifying Databases ................................................ 14
- Identifying Records ................................................... 16
- Identifying Fields ...................................................... 18
- Identifying Extraneous Text ....................................... 20
- Adding and Mapping the Database ......................... 22
- Adding and Mapping Field Tags ............................... 24
  - Determining Fields Tags and Matching ProCite Fields .... 24
  - Mapping a Field You Do Not Want in ProCite .......... 26
  - Mapping a Normal Text Field ............................... 27
  - Mapping the Author Field .................................. 29
    - Setting up the Author Field Format .................. 30
  - Mapping the Source Field ................................ 32
    - Setting up the Source Field Format ................. 35
  - Mapping the Keyword Field .............................. 37
  - Mapping the Remaining Fields ......................... 39
- Importing the Records with ProCite ....................... 40
Chapter 3: Creating, Opening, and Managing Configuration Files
Starting Biblio-Link II ................................................................. 43
Creating, Opening, or Copying a Configuration File .................... 43
   Creating a Configuration File .................................................... 44
   Opening a Configuration File .................................................... 45
   Copying a Configuration File .................................................... 45
Configuration File Properties ....................................................... 46
Closing Files and Exiting Biblio-Link II ....................................... 46
Backing Up Files ........................................................................... 47
Sharing, Deleting, and Renaming Files ........................................ 47

Chapter 4: Locating Databases, Records, and Fields
Overview ...................................................................................... 49
Examining Your Download File ................................................... 49
   Example 1 ................................................................................ 50
   Example 2 ................................................................................ 52
Entering Identifiers ........................................................................ 53
   Entering Database Identifiers ................................................. 54
   Entering Record Identifiers ..................................................... 57
   Entering Field Identifiers ....................................................... 58
   Entering Ignored Strings ....................................................... 61

Chapter 5: Adding and Configuring Databases
Overview ...................................................................................... 63
The Default Database .................................................................... 63
Adding and Mapping Databases ................................................... 64
Modifying Database Settings ....................................................... 67
Copying Database Settings .......................................................... 69
Deleting Databases ........................................................................ 70

Chapter 6: Mapping Records to ProCite Workforms
Overview ...................................................................................... 71
Mapping a Database to a ProCite Workform ................................. 71
Recognizing the Document Type Field ....................................... 72
Adding and Mapping Document Types ....................................... 74
Deleting Document Types ............................................................. 76

Chapter 7: Mapping Field Tags to ProCite Fields
Overview ...................................................................................... 77
Adding and Mapping Field Tags .................................................. 77
   Mapping the Field Tag ............................................................. 79
   Setting Field Attributes .......................................................... 81
   Setting Field Type Options ..................................................... 84
<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Text Options</td>
<td>84</td>
</tr>
<tr>
<td>Multi-Text Options</td>
<td>85</td>
</tr>
<tr>
<td>Parsed Options</td>
<td>86</td>
</tr>
<tr>
<td>Parsed with Subfields Options</td>
<td>88</td>
</tr>
<tr>
<td>Document Type Options</td>
<td>88</td>
</tr>
<tr>
<td>Author Options</td>
<td>89</td>
</tr>
<tr>
<td>Copying Field Tag Definitions</td>
<td>89</td>
</tr>
<tr>
<td>Deleting Field Tags</td>
<td>90</td>
</tr>
</tbody>
</table>

**Chapter 8: Setting the Author Field Format**

Overview | 91 |
Setting the Author Format for the Database | 91 |
Examining the Author Fields | 92 |
Using the Default Database Setting | 92 |
Setting an Author Format | 94 |
Adding the Tag as an Author Field | 95 |

**Chapter 9: Parsing Source Fields**

Overview | 97 |
Setting a Parsed Format for the Database | 97 |
Examining Your Download Files | 98 |
Using the Default Database Settings | 99 |
Setting a Parsed Field Format | 101 |
Adding the Tag as a Parsed Field | 103 |

**Chapter 10: Parsing Tagged Subfields**

Overview | 107 |
Adding the "Parsed with Subfields" Tag | 107 |
Adding and Mapping the Subfield Tags | 109 |

**Chapter 11: Printing Configuration File Settings**

Overview | 113 |
Printing Settings | 113 |

**Appendix A: Troubleshooting** | 115 |

**Appendix B: ProCite Workforms and Fields** | 119 |

**Appendix C: Sample Download Files** | 135 |

**Index:** | 161 |
Chapter 1
Introduction and Installation

Biblio-Link II

Biblio-Link II is a configuration file editor. ProCite uses configuration files to transfer records from information services into your ProCite databases. Each configuration file identifies data elements such as author, title, and publication date, and maps them to the appropriate fields in your ProCite database. Because systems vary greatly in what information they retrieve and how they save it to disk, you typically need a custom configuration file for each system.

Many configuration files are supplied with ProCite, but you can modify them or create new configuration files with Biblio-Link II. For a list of configuration files supplied with ProCite, see Appendix D: Configuration Files.

To actually transfer tagged text into ProCite with the configuration files, use the ProCite Tools menu to Import Text File. This procedure is described in your ProCite User's Guide, Chapter 9: Importing Records.

Downloading Information

You can retrieve information from many different online, CD-ROM, diskette, and Online Public Access (OPAC) databases. It is your responsibility to subscribe to the information service and pay any required fees for downloading and storing records. Biblio-Link II and ProCite are intended to enhance the use of these information services.

When retrieving from an online system, we recommend that you record your entire search session—starting as soon as you sign on and stopping after you sign off. Text appearing before records may contain a database name that is critical for accurate record transfer. You must save to a text-only file.
Configuration files are set up to transfer tagged information. If your information provider offers several download formats, make sure you use the appropriate tagged format! See Appendix C: Sample Download Files for tips about downloading from specific services and an example record from each service.

**Troubleshooting**

If you have problems, first check Appendix A: Troubleshooting and the online Help topics. If those do not answer your questions, contact ISI ResearchSoft Technical Support.

**Help Online**

You can get online help in several ways:

- Select **Help** from the **Menu** bar to find a topic.
- Some windows have a **Help** command button; click on it to see information related to the current window or dialog.
- Display a context-sensitive help topic by pressing the F1 key (Windows) or the **help** key (Macintosh). If no context-sensitive help is available, choose from the list of topics.
Technical Support

Technical support is available to all registered users, Monday through Friday from 8:00 A.M. to 5:00 P.M. Pacific Time. When calling for technical support, please use a phone near your computer and have your serial number available.

To contact technical support:

Mail: ISI ResearchSoft
     800 Jones Street
     Berkeley, CA  94710
     USA

Phone: +01 (510) 559-8592
Fax: +01 (510) 559-8683
Web Site: http://www.procite.com

Email: Windows Technical Support: pc-procite@isiresearchsoft.com
       Macintosh Technical Support: mac-procite@isiresearchsoft.com
       Customer Service: info@isiresearchsoft.com

From Europe, please contact:

Mail: ISI ResearchSoft
     Brunel Science Park, Bldg 1
     Brunel University
     Uxbridge  UB8 3PQ
     UK

Phone: +44 1895-813544
Fax: +44 1895-237-313
Using This Manual

This manual describes both Biblio-Link II for Windows and Biblio-Link II for the Macintosh. The screen examples alternate between the Windows product and the Macintosh product. Everything is essentially the same on both platforms, including menu items and dialog boxes.

To find information and instructions in this manual, check the table of contents at the front of the manual and/or the index at the back of the manual.

Throughout this manual:

- A bold typeface is used when referring to menu names, menu items, and buttons.
- ProCite field names and workform names are indicated with italics.
- Examples are in the sans serif Helvetica font.

Many menu items in Biblio-Link II have a corresponding keyboard equivalent, and some items have a corresponding toolbar icon. The keyboard equivalent appears on the menu next to the associated command. While this manual does not always mention keyboard equivalents or toolbar icons, you can use them at any time.

Installation

Biblio-Link II is automatically installed in the ProCite program folder when you install ProCite. If you have not yet installed ProCite, please do so. If you installed ProCite previously and the Biblio-Link II program does not appear in your ProCite program folder, please see your ProCite User's Guide for information about reinstalling ProCite.
Chapter 2
Getting Started: A Guided Tour

Overview

This chapter guides you through creating and using a basic configuration file that works with a single database. You will identify different parts of a download file, and add and map a database along with its field tags. Setting up a configuration file involves:

- identifying new databases
- identifying the beginning and end of each record
- identifying the beginning and end of each field, and determining the text format
- ignoring extraneous words or phrases between records
- adding and mapping databases
- adding and mapping field tags

This example transfers all records to a single workform, although you can also add individual document types to a configuration file and map them to ProCite workforms.

Because this manual describes both Biblio-Link II for Windows and Biblio-Link II for the Macintosh, the screen examples alternate between the Windows product and the Macintosh product. Everything is essentially the same on both platforms.

You can stop this tour at any time by closing Biblio-Link II.

Examining the Downloaded Records

The first step in setting up a configuration file for a database is to examine a download file of retrieved records. You must save records in a tagged format to a text-only download file.

For this tour, we will create a configuration file that works with Medline records retrieved from the National Library of Medicine's MEDLAR's
A sample download file, titled "MEDLARS - Medline.txt" is found within the ProCite program folder, in the "Download" folder.

To look at the download file:

1. Start ProCite and create a new database named "Tour" (select New from the File menu). This displays an empty record list.

2. Go to the Tools menu and select Import Text File.

3. In the Open Import File dialog, locate ProCite's "Download" folder (under Windows, find "Program Files/ProCite4/Download") and open "MEDLARS - Medline.txt." ProCite will display the download file.

You will often switch back to look at the download file while setting up a working configuration file.

Note: You can also look at download files with a word processor. You can print several pages in order to work with a paper copy, but it's often easier to count spaces and characters onscreen. Do not save any changes when you close the file! It must remain text-only.
Creating the Configuration File

To create a new configuration file:

1. Start Biblio-Link II from the ProCite 4 folder. Under Windows, use the **Start** menu to launch Biblio-Link II from the ProCite program group. A File Open dialog will display.

   **Note**: Leave ProCite open in the background so you can switch back to look at the download file.

2. Click **Cancel** to dismiss the File Open dialog.

3. From the **File** menu, select **New** to display a new file dialog.

4. In the file dialog,
   
a. Type the file name "Lesson". If you are working under Windows or plan to share the file with a Windows user, add the extension .CFG.
   
b. Select the configuration file folder (ProCite 4/Config).
   
c. Click **Save** to create the configuration file on disk and display the database list. A new configuration file starts with only a Default database in the list, and with no field tags defined.

Tip: Adjust the column widths by dragging the column headers: **Name**, **Description**, and **Target ProCite Workform**.
Identifying Databases

Database Identifiers locate database names in your download file, so Biblio-Link II will know from which database your records were retrieved. If the system you use maintains one large database, you don't need to identify new databases, and can simply set up a single Default database. However, many systems are made up of multiple smaller databases.

To set up database identifiers:

1. Switch to ProCite to look at the download file. Scroll through the file to find the text consistently used to identify the database. In MEDLARS download files, the database name appears in a line like this:

   YOU ARE NOW CONNECTED TO THE MEDLINE (1990 - 93) FILE.

   **Note:** Depending on the service provider, you may need to examine several different download files to find a consistent identifier.

2. Switch back to Biblio-Link II.

3. From the **Configuration** menu, select **Database Identification**. The Database Identification screen appears.
4. Click **New** to display the Database Identification Info dialog box:

![Database Identification Info dialog box](image)

5. In the **Prefix** box, type the character string that precedes the database name in your download file. Don't forget the space at the end of the string:

```
YOU ARE NOW CONNECTED TO THE
```

Since there is no consistent text after the database name, leave **Suffix** blank.

6. Click **OK** to save the new settings.

**Note:** You could list multiple prefixes and suffixes; you would simply click **New** again and enter another string. Biblio-Link II will search the list of prefixes and suffixes to attempt a match in the download file.

7. The right side of the Database Identification screen determines how records are mapped when the configuration file does not identify a database name in the download file. As you enter new databases, they appear in this list.
In this case, select **None** so ProCite will prompt you for the database name during the import process.

![Database Identification](image)

8. Click **Done** to save your Database Identification settings.

9. From the **File** menu, select **Save** to save your changes to disk.

### Identifying Records

Record identifiers mark the beginning and end of each record. They help ProCite locate the beginning of a record, to start importing into a new record in ProCite. They also help identify the end of a record, so the entire download file isn't put into one ProCite record.

**To set up record identifiers:**

1. Switch to ProCite to look at the download file. Find the text used to identify the beginning of each record. In MEDLARS download files, each record is numbered sequentially, such as:

```
1  
UI - 93143593
AU - Popper SE ; McCloskey K
TI - Individual differences and subgroups within populations: the shopping bag approach.
```

```
2  
UI - 93141869
AU - Battegay R
TI - [Anxiety, a basic human experience]
```
2. Switch back to Biblio-Link II.

3. From the Configuration menu, select Record Identification. The Record Identification screen appears.

4. In the Header Format box, type the record header that appears before each new record in your download file. In this case, type a pound sign (#) to indicate "any number."

   **Tip:** Use the pound sign (#) for "any number," and the asterisk (*) for "any character." If you want to include a literal pound sign or asterisk in your character string, precede it with a backslash (\). For example, "\#" will specifically look for a pound sign in your text, while "+#" will look for *any* number.

5. In the Terminated By section, define the end of each record with Blank Line, where each blank line signifies the end of the current record.

6. Click OK to save your settings.

7. From the File menu, select Save to save your file to disk.
Identifying Fields

Field identifiers mark the beginning and end of each field, and the format of each field. You must identify these correctly in order to transfer any information.

To set up field identifiers:

1. Switch to ProCite to look at the download file. Examine the layout of each field. In MEDLARS download files, the field tags are separated from field text by "space space hyphen space" as shown below. The "tag" is the code at the beginning of each field that identifies it, such as AU for Author.

   UI - 93143593
   AU - Popper SE ; McCloskey K
   AB - The aerospace medical research community needs to consider the individual as some thing other than a statistical entity....

   Notice that second and subsequent lines in a field are indented.

2. Switch back to Biblio-Link II.

3. From the Configuration menu, select Field Identification. The Field Identification screen appears.

   ![Field Identification Screen]

   - **Tag Format:** 
     - \$ - Tag Position
     - * = Any Character(s)
     - # = Any Number
   - **Tag Length:**
     - Variable
     - Fixed
   - **Text Following Tag:**
     - OFF
   - **Fixed Width Tag Area:** 6

   Processing Options:
   - **Terminator:**
   - **Empty String:**
   - **Line Continuation:** Indented
   - **Case Conversion:** No Conversion

   ![Field Identification Options]

   - **OK**
   - **Cancel**
4. In the **Tag Format** box, enter the MEDLAR's format for a field tag. To match this format:

```
AU  - Popper, SE
```

you should enter "$ - " (dollar sign, space, hyphen, space). Enter a single space to indicate any number of spaces.

You can use these special characters as needed:

- $ (dollar sign) indicates the position of the tag itself
- # (pound sign) means "any number"
- * (asterisk) means "any character(s)"

5. Indicate that the **Tag Length** is **Fixed** and enter a **Field Tag Length** of 2, since all tags in the download file consist of two characters.

---

**Note:** Later, you may notice that the full MEDLARS configuration file indicates a variable field tag length. That is because other MEDLARS databases do allow variable-length tags. You are setting up this example file only for Medline records.

---

6. Do not select **CR Follows Tag**; field text appears on the same line as the field tag.

7. The distance from the beginning of a tag to the text of the field is always the same number of characters, so select **Fixed Width Tag Area**. When you select this, a text box appears. Enter the length (number of characters, including spaces) in the text box: 6.

8. In the example download file, there is no character that appears at the end of each field, nor is there any character that indicates an empty field. Leave the **Terminator** and **Empty String** boxes blank.

9. Use the pull-down list next to **Line Continuation** to select the paragraph format used for field text. In this case, second and subsequent lines of text in a field are **Indented**.

10. Use the pull-down list next to **Case Conversion** to handle upper and lowercase characters during the transfer. For these records, select **No Conversion** to transfer text without any changes in case.

11. Click **OK** to save your settings.

12. From the **File** menu, select **Save** to save your file to disk.
Identifying Extraneous Text

"Ignored strings" are extraneous lines of text that appear in your download file that should not transfer into ProCite records. These are typically command prompts from online systems. Any line beginning with an ignored string is completely ignored for transfer.

**To enter text you want ignored:**

1. Switch to ProCite to look at the download file. Look for command prompts at the beginning of the file, between records, and at the end of the file. In the sample download file, you will find extra lines that begin with:

   ```
   USER:
   PROG:
   CONTINUE PRINTING?
   ```

   While you may find other lines of extraneous text, it is only helpful to list those lines that are consistent.

2. Switch back to Biblio-Link II.

3. From the **Configuration** menu, select **Ignored Strings** to display a blank Ignored Lines dialog.

4. Click **New** to add a new line to the list. The Ignored Line Format String dialog will appear.

   ![Ignored Line Format String](image)

5. Type "USER: " in the **Line Format** text box.

   **Tip**: You can use these special characters: # (any number) and * (any character).

6. Click **OK** to save your entry.

7. Click **New** again and enter "PROG: "; click **OK** to save the entry.
8. Click **New** again and enter "CONTINUE PRINTING?"; click **OK** to save the entry.

![Ignored Lines dialog](Image)

9. Click **Done** to save changes to the Ignored Lines dialog.

10. From the **File** menu, select **Save** to save your changes to disk.
Adding and Mapping the Database

Now that ProCite can locate all the parts of the download file, you must add and map the individual database itself.

To add and map a database:

1. Since this is a new configuration file, only the Default database appears in the database list:

   ![Database List Screen]

   - **Name**: Default
   - **Description**: Default Database Definition
   - **Target ProCite Workform**: Book Long Form

2. Click the New button. The Database Information dialog appears.

3. In the Name text box, type the database name "MEDLINE". The database name is the name as it appears in your download file.

4. You can enter a longer name in the Description text box. This text helps you identify the database. For this example, enter "Medline (1990-1993)".
5. Use the **ProCite Workform** pull-down list to select *Journal Long Form* as the destination ProCite workform. Records retrieved from the database will transfer into this workform in ProCite.

![Database Information]

**Note:** You can map each database to a single ProCite workform. However, if the records include a field that contains a description of the document type, you can recognize and map those document types to the appropriate ProCite workform. For this example, all records will transfer to *Journal Long Form*.

6. Click **OK** to save the new database settings and display a blank field list:

![Lesson_CFG: Database 'MEDLINE']
Adding and Mapping Field Tags

Separate field lists are maintained for each database from an information service. If your information provider offers a single database of records, you can set up the Default database to work with all records. Otherwise, you create a field list for each database.

Tip: For fields that are the same between databases, you can set the field up once and then copy and paste that field definition for other databases. See Chapter 7: Mapping Field Tags to ProCite Fields for more information.

This section describes how to map fields you do not want transferred into ProCite as well as normal text fields, author fields, source fields, and keyword fields.

Determining Fields Tags and Matching ProCite Fields

Switch to ProCite and look at the download file. Compile a complete list of field tags used in the file, a description of what is in each field, and a target ProCite field for the text. Some records may contain tags not found in other records.

If your information service provides a comprehensive field list, use it as a guide so you include all tags. Keep in mind that tags used for searching the database may not be the same tags saved to download files.

To determine target ProCite fields, use Appendix B: ProCite Workforms and Fields. Since all of our example records are journal references, we can map all fields to match ProCite’s Journal Long Form workform.
Our example file includes the tags listed below (you can enter the tags in any order, although we've sorted these for you. The guided tour will walk you through mapping several types of tags. You can then continue mapping the rest of the tags on your own.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
<th>ProCite Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA</td>
<td>Abstract Author</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>AB</td>
<td>Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>AD</td>
<td>Address</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>AU</td>
<td>Author</td>
<td>01 Author, Analytic</td>
</tr>
<tr>
<td>DA</td>
<td>Date of Entry</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>DP</td>
<td>Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>EA</td>
<td>English Abstract Indicator</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>EM</td>
<td>Entry North</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>IP</td>
<td>Issue/Part/Supplement</td>
<td>24 Issue ID</td>
</tr>
<tr>
<td>IS</td>
<td>ISSN</td>
<td>40 ISSN</td>
</tr>
<tr>
<td>JC</td>
<td>Journal Title Code</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>LA</td>
<td>Language</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>MH</td>
<td>MESH Headings</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>PG</td>
<td>Pagination</td>
<td>25 Pages</td>
</tr>
<tr>
<td>PT</td>
<td>Publication Type</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>RN</td>
<td>CAS Registry Number</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>SB</td>
<td>Journal Subset</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>SO</td>
<td>Source</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>TA</td>
<td>Title Abbreviation</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>TI</td>
<td>Title</td>
<td>04 Article Title</td>
</tr>
<tr>
<td>TT</td>
<td>Translit/Vernac Title</td>
<td>42 Notes</td>
</tr>
<tr>
<td>UI</td>
<td>Unique Identifier</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>VI</td>
<td>Volume Issue</td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>ZN</td>
<td>Mesh Z Tree Number</td>
<td>Do Not Transfer</td>
</tr>
</tbody>
</table>
Mapping a Field You Do Not Want in ProCite

First, we'll map a field that you do not want transferred into ProCite. You need to add all field tags—even those you don't want transferred—so that ProCite won't include the text as part of the previous field. In this case, we'll map the field tag AA (Abstract Author).

To map a field you do not want transferred:

1. Switch back to Biblio-Link II if you are not already there.

2. From the Medline field list (which is currently blank), click the New Field button at the bottom of the dialog. This displays a Field Information dialog.

3. Enter basic information at the top of the dialog:
   
   **Field Tag:** AA  
   **Description:** Abstract Author  
   **ProCite Field:** Do Not Transfer

   When you select *Do Not Transfer*, other settings on the dialog are ignored.

4. Click OK to save changes. You are returned to the field list, where AA now appears.

5. Select Save from the File menu to save changes to disk.
Note: The supplied configuration files are set up to transfer fields to satisfy most users. You can modify the field transfer at any time! For example, if the name of the abstract author is important to you, transfer it to a ProCite field (perhaps the 42 Note field).

Mapping a Normal Text Field

Next, map the AB tag. This is a normal text field that requires no manipulation. Most fields are transferred as normal text.

To map a normal text field:

1. From the Medline field list, click the New Field button at the bottom of the dialog to display a Field Information dialog.

2. Enter basic information at the top of the dialog:
   
   Field Tag: AB  
   Description: Abstract  
   ProCite Field: 43 Abstract

3. In the Attributes section of the Field Information dialog:
   
   a. Set the Field Type to Normal Text so ProCite transfers the text intact.
b. Leave both the **Begins With** box and the **Ends With** box empty, since MEDLARS does not mark the beginning or end of field text with special text.

c. Set **Case Conversion** to **Default** to use the default setting for case conversion. (We set no conversion as the default earlier.)

d. Leave the **Space Character** box empty, since MEDLARS does not indicate spaces with a character.

e. Do not select the **Compress Multiple Spaces** box, since there are no instances extraneous spaces in the download file.

4. When you selected the field type **Normal**, an extra Options section appeared on the dialog.

   a. Indicate that carriage returns are replaced by a **Space**.

   b. Indicate that carriage returns are represented by **Carriage Return (Normal)**.

5. Click **OK** to save changes and return to the field list. The field tag AB now appears in the list.

6. Select **Save** from the **File** menu to save changes to disk.
Mapping the Author Field

This section describes how to map an author field. Author names often need manipulation so they will transfer into the appropriate ProCite author format. The appropriate format is necessary so you can search for author names in ProCite and print them in various output formats.

To add and map the AU field tag:

1. From the Medline field list, click the **New Field** button at the bottom of the dialog to display a Field Information dialog.

![Field Information Dialog](image)

2. Enter basic information at the top of the dialog:

   - **Field Tag**: AU
   - **Description**: Author
   - **ProCite Field**: 01 Author, Analytic

3. In the Attributes section of the Field Information dialog,

   a. Set the **Field Type** to **Author** so ProCite can translate author names into the appropriate ProCite format.

   b. Leave both the **Begins With** box and the **Ends With** box empty, since MEDLARS does not mark the beginning or end of field text with special text.

   c. Set **Case Conversion** to **Default** to use the default setting for case conversion. (We set no conversion as the default earlier.)
d. Leave the **Space Character** box empty, since MEDLARS does not indicate spaces with a character.

e. Do not select the **Compress Multiple Spaces** box, since there are no instances extraneous spaces in the download file.

4. When you selected the field type Author, an extra Options--Author section appeared on the dialog. Do not select the **Corporate Author** box, since you want ProCite to translate personal author names.

5. Click **OK** to save changes.

6. Select **Save** from the **File** menu to save changes to disk.

You still need to indicate the author field format as described next.

**Setting up the Author Field Format**

You have mapped the AU field to a ProCite author field. Next, ProCite needs to know what form author names appear in, so they can translate into the correct form for ProCite. You need to set up the author field format only once for each database, even if you map more than one author field for the database.

**To set up the author format:**

1. Switch to ProCite to examine several AU fields in the download file. Authors appear in this format:

   Popper SE ; McCloskey K

2. Switch back to Biblio-Link II.

3. Make sure the Medline database is highlighted, or that the Medline field list is displayed. A single author field format can be set up for each database.

4. From the **Configuration** menu, select **Author Field Format** to display the current author format for the Medline database.
5. Deselect the **Use Default Database's Format** box.

**Note:** If many of the databases from this service format author names the same way, you may be able to simply check **Use Default Database's Format**. For this example, however, we want to show you how to set up an individual author format.

6. Toward the bottom of the dialog, clear the **Spaces are represented by hyphens** box. This item shows or removes hyphens from the author names on the dialog.

7. Click a radio button to select the author format that most closely matches the author names in the download file. In this case, it is in the right column:

![Author Format for DB 'MEDLINE'](#)

8. At the bottom of the dialog, enter the character(s) that separate individual author names. In this case, it is " ; " (space semicolon space). When author names transfer into ProCite, these characters translate into the ProCite author separator (///).

9. Click **OK** to save your changes.
Mapping the Source Field

This section describes how to map the source field. Source fields contain multiple types of information that should transfer into separate ProCite fields. They contain some combination of journal title, date, volume, issue, pages, ISSN, and CODEN. You need to split the field to accommodate searching and varied output.

To add and map the SO field tag:

1. From the Medline field list, click the New Field button at the bottom of the dialog to display a Field Information dialog.

2. Enter basic information at the top of the dialog:

   - **Field Tag**: SO
   - **Description**: Source
   - **ProCite Field**: Do Not Transfer

**Note**: Normally, to parse the Source field, you would map to the ProCite field 10 Journal Title. However, Medlars provides the same information twice—in the SO field and in separately tagged fields. For this tour, map to Do Not Transfer, so you will not get duplicate entries in these fields (like two of the same dates in the date field).
3. In the Attributes section of the Field Information dialog:
   a. Set the Field Type to Parsed so ProCite can parse (separate) each bit of information for transfer to appropriate ProCite fields.
   b. Leave both the Begins With box and the Ends With box empty, since MEDLARS does not mark the beginning or end of field text with special text.
   c. Set Case Conversion to Default to use the default setting for case conversion. (We set no conversion as the default earlier.)
   d. Leave the Space Character box empty, since MEDLARS does not indicate spaces with a character.
   e. Do not select the Compress Multiple Spaces box, since there are no instances extraneous spaces in the download file.

4. When you selected the field type Parsed, an extra Options--Auto-Parsed section appeared on the dialog. Under Options--Auto-Parsed, you indicate target fields in order to send each component to the appropriate ProCite field.

Since our records are all journal entries, we are concerned with only the Journal Long Form workform. For the journal workform, the fields should map to:

```
Title .................. 10 Journal Title
Volume ............. 22 Volume ID
Issue ............... 24 Issue ID
Page Number .. 25 Pages
Date ................. 20 Date of Publication
ISSN ................ 40 ISSN
CODEN ............ 39 CODEN
```

The default settings work well with the predefined workforms. To check the appropriate ProCite fields for the predefined workforms, see Appendix B: ProCite Workforms and Fields.
By default, Title is mapped to field 09 Title, Monographic for journal workforms; this accommodates users of earlier versions. When ProCite 4 attempts to transfer to field 09 and discovers the field does not exist in the workform, the data is redirected to field 10 Journal Title. For this example, however, you will explicitly map the Title to ProCite field 10 Journal Title.

a. Next to Title, click Select to display the Auto-Parsed Target Field dialog. This dialog lists the target field for each workform.

b. Since our records are all journal entries, double click on Journal Long Form to display:

Use the drop-down list to select the 10 Journal Title field and click OK to save the change.

c. Click Done to save the new setting.

5. Click OK to save changes to the Field Information dialog.

6. Select Save from the File menu to save changes to disk.

You still need to indicate the source field format as described next.
Setting up the Source Field Format

You have mapped the SO field as a Parsed field. Next, ProCite needs to know in what form the source field appears.

To set up the parsed format:

1. Switch to ProCite to examine several SO fields. Source fields appear in this format:

   Aviat Space Environ Med 1993 Jan; 64(1):74-7

   Note the included fields, field order, and punctuation between fields:

   Title Date; Volume(Issue):Pages

2. Switch back to Biblio-Link II.

3. Make sure the Medline database is highlighted, or that the Medline field list is displayed. A single parsed field format can be set up for each database.

4. From the Configuration menu, select Parsed Field Format to display the current parsed field format for the Medline database.

5. Deselect the Use Default Database's Format box. The Example box at the bottom of the dialog shows the current settings on the dialog.

6. Under Component, use the pull-down lists to list the order in which items appear in your source fields. In this case, list:

   Title
   Date
   Volume
   Issue
   Pages
   None
   None

   **Note:** If a component appears in most records, but not in others, you should still include it here. For example, some records may contain all five components (title, date, volume, issue, and pages) while others may include only a subset. You would still list all five fields.
7. Check the **Optional** box next to each of the five components. If they appear, ProCite will parse them; if they don't appear the parsing information for those fields is ignored.

8. In the **Preceded By** and **Followed By** text boxes, enter the text and/or punctuation that separates each bit of information. In our example,

Aviat Space Environ Med 1993 Jan; 64(1):74-7

these settings work well to parse each item:

Don't forget spaces, which *are* significant. This example includes a space after Title, a semicolon and space before Volume, parentheses before and after Issue, and a colon before Pages.

These settings are rather subjective, since punctuation can be entered as either ending text for one field or preceding text for the next field. It is not always clear which will work best for ProCite.
**Tips:**

- When entering preceding and ending text for optional fields, make sure you include only punctuation that appears or disappears depending on whether the field is present.

- You can use an asterisk "*" as a wild card in preceding text, meaning that any text is acceptable. For example, you could use "*:=" as preceding text before the first component to get rid of extraneous characters (that end with a period) before the source information.

- You can use a backslash-r (\r) to indicate a line break after a component.

9. To save changes to the parsing format for the Medline database, click **OK**.

10. Select **Save** from the **File** menu to save changes to disk.

**Mapping the Keyword Field**

This section describes how to map a keyword field. Keywords are also referred to as descriptors, categories, or headings. ProCite needs to identify the field as multi-text in order to insert the appropriate separators. Appropriate separators are necessary in ProCite so you can search by keyword and organize bibliographies by subject.

**To add and map the MH (Mesh Headings) field tag:**

1. Switch to ProCite to examine several MH fields. These fields appear in this format:

   *Aerospace Medicine ; Fatigue/BLOOD ; G Suits ; Human;
   *Human Engineering ; *Individuality ; Lactates/BLOOD ; Protective Devices ; Research ; Task Performance and Analysis

   Note that keywords are separated by a space, a semicolon, and another space. (Once the records are in ProCite, you may want to globally remove the asterisks.)

2. Switch back to Biblio-Link II.
3. From the Medline field list, click the **New Field** button at the bottom of the dialog to display a Field Information dialog.

![Field Information Dialog](image)

4. Enter basic information at the top of the dialog:

   - **Field Tag**: MH
   - **Description**: MESH Headings
   - **ProCite Field**: 45 Keywords

5. In the Attributes section of the Field Information dialog,
   
a. Set the **Field Type** to **Multi-text** so ProCite can translate keywords into the appropriate ProCite format.

b. Leave both the **Begins With** box and the **Ends With** box empty, since MEDLARS does not mark the beginning or end of field text with special text.

c. Set **Case Conversion** to **Default** to use the default setting for case conversion. (We set no conversion as the default earlier.)

d. Leave the **Space Character** box empty, since MEDLARS does not indicate spaces with a character.

e. Do not select the **Compress Multiple Spaces** box, since there are no instances extraneous spaces in the download file.
6. When you selected the field type **Multi-Text**, an extra Options--Multi-Text section appeared on the dialog. Enter the character(s) that separate keywords in the field. In this case, they are separated by " ; " (space semicolon space). ProCite will replace the separator with a slash during record transfer.

7. Click **OK** to save changes.

8. Select **Save** from the **File** menu to save changes to disk.

**Mapping the Remaining Fields**

You can continue mapping the rest of the fields until all appear in the Medline field list —either as normal text fields or designated *Do Not Transfer*.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
<th>ProCite Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA</td>
<td>Abstract Author</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>AB</td>
<td>Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>AD</td>
<td>Address</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>AU</td>
<td>Author</td>
<td>01 Author, Analytic</td>
</tr>
<tr>
<td>DA</td>
<td>Date of Entry</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>DP</td>
<td>Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>EA</td>
<td>English Abstract Indicator</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>EM</td>
<td>Entry North</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>IP</td>
<td>Issue/Part/Supplement</td>
<td>24 Issue ID</td>
</tr>
<tr>
<td>IS</td>
<td>ISSN</td>
<td>40 ISSN</td>
</tr>
<tr>
<td>JC</td>
<td>Journal Title Code</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>LA</td>
<td>Language</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>MH</td>
<td>MESH Headings</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>PG</td>
<td>Pagination</td>
<td>25 Pages</td>
</tr>
<tr>
<td>PT</td>
<td>Publication Type</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>RN</td>
<td>CAS Registry Number</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>SB</td>
<td>Journal Subset</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>SO</td>
<td>Source</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>TA</td>
<td>Title Abbreviation</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>TI</td>
<td>Title</td>
<td>04 Article Title</td>
</tr>
<tr>
<td>TT</td>
<td>Translit/Vernac Title</td>
<td>42 Notes</td>
</tr>
<tr>
<td>UI</td>
<td>Unique Identifier</td>
<td>Do Not Transfer</td>
</tr>
<tr>
<td>VI</td>
<td>Volume Issue</td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>ZN</td>
<td>Mesh Z Tree Number</td>
<td>Do Not Transfer</td>
</tr>
</tbody>
</table>
When all the fields are mapped, click the close box to close the field list and return to the database list.

Click the program close box, or **Exit/Quit** from the **File** menu, to close the configuration file and leave Biblio-Link II. You may be prompted to save changes.

The new configuration file is ready for use.

---

**Importing the Records with ProCite**

This section walks you through transferring a file of records retrieved from the Medline database offered by the National Library of Medicine's MEDLARS system. You will use the configuration file created during the guided tour. (If you did not finish the guided tour, you can use the MEDLARS configuration file supplied with ProCite.)

**Note:** While this process was accurate at print time, the ProCite program may have changed slightly since then.

**To import tagged records:**

1. In ProCite, select **Import Text File** to display the download file:
   
   - If you have been following the Guided Tour, ProCite already has a new database named "Tour" open. You already selected **Import Text File** from the **Tools** menu to display the "Medlars - Medline.txt" download file.
   
   - If you have not been following the Guided Tour, start ProCite and create a new database named "Tour." Go to the **Tools** menu and select **Import Text File** to display a file dialog. Locate and open the text file that contains the tagged records you want to import into ProCite. For this lesson, navigate to ProCite's "Download" folder and select the file "MEDLARS - Medline.txt". ProCite will display the file onscreen.
2. In the **File Type** drop-down list, select **Tagged**.

3. In the **File Format** drop-down list, select the service from which you retrieved the tagged records. In this case, select **LESSON** (the configuration file created by following the Guided Tour) or **MEDLARS**. If the file you want is not listed, use the ... button and use the file dialog to locate the file.

4. In the **Target Database** drop-down list, select the "Tour" database. If it is not listed, click on the ... button and use the file dialog to locate the database.

5. Click the **Transfer** button to begin importing records.

   When the transfer is completed, ProCite will tell you how many records were imported into your database. Click **OK** to dismiss the alert.
6. Click the close box to close the text file and display the database record list.

Tip: The imported records are marked. When you are adding to an existing database, you can see only those records that you just transferred by selecting Marked Records for viewing.

You can view full records to make sure fields of information transferred correctly. If fields did not transfer into the ProCite fields of your choice, you can:

1. Delete the marked records.

2. Start Biblio-Link II and modify the configuration file, changing field mapping as appropriate.

3. Use ProCite to import the download file again.
Chapter 3
Creating, Opening, and Managing Configuration Files

Starting Biblio-Link II

When you install ProCite, a ProCite 4 folder is created containing a ProCite icon and a Biblio-Link II icon. Double click on the Biblio-Link II icon to start the program.

Or, from the Windows Start menu, you can go to Programs, then ProCite, and select the Biblio-Link II icon.

A File Open dialog will display, allowing you to find and select a configuration file to open. If you want to create a new configuration file, first click Cancel in the File Open dialog.

Creating, Opening, or Copying a Configuration File

You can create any number of configuration files. You can create a single configuration file for each bibliographic data system you use, or you can create a single configuration file for a specific database (or group of databases) within a bibliographic data system.

Tip: If you plan to create a configuration file that is similar to an existing file, we recommend that you copy the existing file and modify it. This can save you much time in entering field names, descriptions, applying field attributes, etc.
Creating a Configuration File

If you are working on a network drive, make sure you have read-write access to the folder where you wish to create the configuration file.

To create a new configuration file:

1. Start Biblio-Link II. A File Open dialog will display.
2. Click Cancel to dismiss the File Open dialog.
3. From the File menu, select New to display a Save As dialog.
4. In the Save As dialog,
   a. Type in a file name for the configuration file. This name is used to store the file on disk.
   b. Select the appropriate folder (typically the Config folder found in the ProCite program folder).
   c. Click Save to create the configuration file on disk and display the database list. A new configuration file starts with only a Default database in the list, and with no field tags defined.
Chapter 3: Creating, Opening, and Managing Configuration Files

Opening a Configuration File

You can open a configuration file simply to check or print settings, or to edit the file.

**To open a configuration file when Biblio-Link II is not running:**
1. Launch the Biblio-Link II icon. A File Open dialog will display.
2. Locate and open the configuration file to display the database list.

**To open a configuration file when Biblio-Link II is already running:**
1. Go to the **File** menu and select **Open**. A File Open dialog will display.
2. Locate and open the configuration file to display the database list.

Copying a Configuration File

Configuration files are disk files usually stored in the "Config" folder found in the ProCite program folder. Under Windows, configuration files always include the extension .CFG.

Open the file with Biblio-Link II and select **Save As** from the **File** menu. In the Save As dialog, enter a name for the new configuration file, locate the appropriate folder, and click **Save** to write the file to disk. Biblio-Link II will display the new file.

You can also duplicate a configuration file with the Windows Explorer or Macintosh Finder.
Configuration File Properties

To view configuration file properties and add or update notes about the file, go to the Configuration menu and select File Information.

Closing Files and Exiting Biblio-Link II

To close a configuration file, select Close from the File menu. Biblio-Link II may prompt you to save changes. This closes the configuration file, but Biblio-Link II is still open.

Click the program Close box to close all configuration files and exit Biblio-Link II. Or, from the File menu, choose Exit (Windows) or Quit (Macintosh).
Chapter 3: Creating, Opening, and Managing Configuration Files

Back up Files

Loss of a custom configuration file is inconvenient, and it can be very expensive to re-enter and re-map hundreds of field tags. Back up your configuration files, especially after making numerous changes or additions.

We recommend that you keep an "archival" backup of your configuration files (along with your ProCite files) on separate disks from your regular backups. You will still have an old backup to restore even if your regular backups were made after your hard disk developed a bad sector. Even an archive that is several months old could save you from re-creating a configuration file.

You can back up a single configuration file simply by copying it to a diskette. If your file is large, or you want to back up several files, you can use the Backup utility included with Windows or any backup utility available from a third-party vendor.

Sharing, Deleting, and Renaming Files

Configuration files are separate disk files, and they are usually stored in the "Config" folder found in the ProCite program folder.

You can share a configuration file with a user on another machine by copying it to a diskette so that user can copy the file to his/her "Config" folder. If you are sharing the configuration file with a ProCite for Windows user, make sure the filename includes a .CFG extension.

If multiple users are running the same copy of ProCite from a network, the installed configuration files are available to all of the users for data importing with ProCite. However, when a configuration file is open for editing, it is not available to other users for either editing or data importing.

Use the Windows Explorer or Macintosh finder to delete or rename a configuration file.
Chapter 4
Locating Databases, Records, and Fields

Overview

Database, record, and field identifiers define the overall layout of your download files. You must define how downloaded information was formatted to disk by the information service so ProCite can correctly locate each item. If any one of these definitions is incorrect, you will either have information transferred incorrectly or not at all. This chapter explains how to examine your download file and define the appropriate settings in a configuration file.

These settings should be the same for all files downloaded from a single information provider. If two databases from the same provider do not share these settings, you must create two different configuration files.

In most cases, you need to set this information up only once. However, if an information service changes the way records are output to disk, you may need to modify these settings in the existing configuration file.

Examining Your Download File

The first step in setting up a configuration file for an information service is to examine a download file of records retrieved from that service. You must retrieve records in a tagged format to a text-only download file. To look at a download file, you can do one of these:

- Open it with a word processor. You may want to print several pages in order to work with a paper copy. Do not save any changes when you close the file!

- In ProCite, go to the Tools menu and select Import Text File. In the File Open dialog, select your download file for display.
In the download file, you find unique characters or formatting that determines how to:

- identify new databases
- find the beginning and end of each record
- find the beginning and end of each field, and the text format
- ignore extraneous words or phrases, such as "Hit return to continue"

The next section of this chapter, *Entering Identifiers*, explains how and where to enter the appropriate settings with Biblio-Link II. As you go through *Entering Identifiers*, you may want to refer to the download file examples shown here. They illustrate the type of information you need to determine from your own download file.

**Example 1**

This example is a slightly modified version of downloaded records from MEDLARS. Several prompts and fields were removed for clarity. In general, you should NOT modify your download file before transferring records.
These are the settings that will help identify components of the file:

**Database Identification**

Prefix: YOU ARE NOW CONNECTED TO THE

**Record Identification**

Header Format: #
(The pound sign indicates any number.)

Terminated By: One Blank Line
(There is a single blank line after each record.)

**Field Identification:**

Tag Format: $ -
(The dollar sign represents the tag, and the "space hyphen space" appears between the tag and the field text. Use a single space to indicate any number of spaces.)

Tag Length: Variable
(While the example shows a fixed tag length of two characters, further inspection of the file found several three character tags. You may need to scan an entire file to catch such variations.)

Line Continuation: Indented
(Second and subsequent lines in the same field are indented.)

Case Conversion: No Conversion
(Most text is appropriately capitalized, so no case conversion is applied. Note that the PT field is in uppercase. You can later apply case conversion only to that field.)

**Ignored Lines:**

Line Formats: USER:
PROG:
(The example shows only "USER:". You may need to scan the entire file to find other extraneous prompts saved to disk by the information service.)
Example 2

This example is a slightly modified version of downloaded records from SilverPlatter. Several prompts and fields were removed for clarity. In general, you should NOT modify your download file before transferring records.
These are the settings that will help identify components of the file:

**Database Identification**

Prefix: Record # of # -  
(The pound sign indicates any number.)

**Record Identification**

Header Format: Record # of # - *  
(The pound sign indicates any number, and the asterisk indicates any characters.)

Terminated By: String:  ---------  
(There is a line of hyphens after each record.)

**Field Identification:**

Tag Format: $:  
(The dollar sign represents the tag, and the colon appears between the tag and field text)

Tag Length: Variable  
(The example shows both two and four character tags.)

Line Continuation: Left Margin  
(Second and subsequent lines in the same field wrap to the left margin.)

Case Conversion: No Conversion  
(Most text is appropriately capitalized, so no case conversion is applied. Note that the LA field is in uppercase. You can later apply case conversion only to that field.)

**Ignored Lines:**

Line Formats: USER:  
PROG:  
(The example shows only "USER:". You may need to scan the entire file to find other extraneous prompts saved to disk by the information service.)

**Entering Identifiers**

Database, record, and field identifiers define the overall layout of your download files. These settings should be the same for all files downloaded.
Entering Database Identifiers

Database Identifiers locate database names in your download file, so Biblio-Link II will know from which database your records were retrieved.

If the system you use maintains one large database, you can ignore this section. However, many systems are made up of multiple smaller databases. Since you most likely will want to map items differently for records from the different databases (records to workforms, and tagged fields to ProCite fields), the configuration file needs to identify which database from which records were retrieved.

If you haven't read it already, see Examining Your Download File earlier in this chapter. It shows examples for determining what text identifies a database name.

To set up a database identifier:

1. From the Configuration menu, select **Database Identification**. The Database Identification screen appears.
2. The left box lists text that appears before or after a database name in your download file. This should be consistent text that will always flag a database name. To add a character string to the list:

- Click **New** to display the Database Identification Info dialog box:

  ![Database Identification Info dialog box](image)

  b. In the **Prefix** box, type the character string that precedes a database name or number in your download file.

  **Tip**: Use special characters for varying items. Use # (pound sign) for "any number" and use * (asterisk) for "any character."

  For example, if this text indicates that the following records are from the database MEDLINE:

  Record 1 of 10 - MEDLINE

  You would enter a Prefix of:

  Record # of # -

c. In the **Suffix** box, type the character string (if any) that follows a database name in your download file.

d. Click **OK** to save the new settings.

You can list multiple prefixes and suffixes; simply click **New** again and enter another string. Biblio-Link II will search the list of prefixes and suffixes to attempt a match in the download file.

You can modify or delete an existing item by highlighting it and clicking the **Modify** or **Delete** button.
3. The right side of the Database Identification screen determines how records are mapped when the configuration file does not identify a database name in the download file:

Biblio-Link II will not identify a database name when:

- The correct prefix and/or suffix strings have not been entered. You need to determine what they are and enter them.
- The information system changed the strings used. You need to enter the new strings.
- The database name was not included in the download file at all. You need to find out whether your information system can include it on output.

In most cases, you will want to select either None (ProCite may prompt you for the database name during the import process) or the Default database (where we recommend defining all common field tags).

If you transfer records primarily from one particular database, you may want to set that database as the default. Note that specific database names do not appear until you have entered them as described in Chapter 5: Adding and Configuring Databases.

4. Click Done to save your Database Identification settings.

5. From the File menu, select Save to save your changes to disk.
Entering Record Identifiers

Record identifiers mark the beginning and end of each record. These are critical. ProCite needs to know when a record has begun, to start importing. Plus, you don't want your entire download file dumped into one ProCite record!

If you haven't read it already, see Examining Your Download File earlier in this chapter. It shows examples for determining what text identifies a new record.

To set up a record identifier:

1. From the Configuration menu, select Record Identification. The Record Identification screen appears.

2. In the Header Format box, type the record header that appears before each new record in your download file.

Tip: You can include special characters in your Header Format or termination String. Use the pound sign (#) for "any number," and the asterisk (*) for "any character." If you want to include a literal pound sign or asterisk in your character string, precede it with a backslash (\). For example, "#" will specifically look for a pound sign in your text, while "#" will look for any number.

For example, this header format:

Record # of #

would match this text:

Record 2 of 35
3. In the **Terminated By** section, define the end of each record with one of these:

   - **Blank Line**, where each blank line signifies the end of the current record
   - **Two or More Blank Lines**, which allows for single blank lines within a record (such as within an abstract) and two or more lines between records
   - **String**, where you then type the text string that ends each record

4. Click **OK** to save your settings.

5. From the **File** menu, select **Save** to save your file to disk.

### Entering Field Identifiers

Field identifiers mark the beginning and end of each field, and the format of each field. You must identify these correctly in order to transfer any information.

If you haven't read it already, see *Examining Your Download File* earlier in this chapter. It shows examples of what identifies a new field.

**To enter a field identifier:**

1. From the **Configuration** menu, select **Field Identification**. The Field Identification screen appears.
2. In the **Tag Format** box, enter the information service's format for a field tag. The "tag" is the code at the beginning of each field that identifies it, such as *AU* for *Author*.

Use these special characters as needed:

- $ (dollar sign) indicates the position of the tag itself
- # (pound sign) means "any number"
- * (asterisk) means "any character(s)

For example, to match this format:

```
AU: Rieger, Steve
```

you would enter:

```
$: 
```

3. Indicate whether the **Tag Length** is **Variable** or **Fixed**.

- Select **Variable** if your tags are not all the same length.
- Select **Fixed** if all tags are the same length. A text box appears. Enter the length of the tag. For example, the tag AU has a fixed length of 2.

4. If your file displays a field tag on one line and the field text on the next line, select the **CR Follows Tag** item. An example of this is:

```
Author:
Smith, Gwendolyn
Title:
Childhood Allergies
```

5. If the distance from the beginning of a tag to the text of the field is always the same number of characters, select **Fixed Width Tag Area**. When you select this, a text box appears. Enter the length (number of characters, including spaces) in the text box.

6. Under **Processing Options**, enter the field **Terminator** (if there is one). For example, Dialog ends every field with a vertical bar "|". Most services do not use a field terminator.

7. If the information service uses a character string to identify an empty field, type that text in the **Empty String** box. For example, it could use the text "None".
8. Use the pull-down list next to **Line Continuation** to select the format used when field text consists of more than one line.

- **Indented** is where the next line is indented to the same column as the previous text line, as in:

  AU: xxxxx
  
  xxxx

- **Left Margin** is where the new line is continued at the left margin, as in:

  AU: xxxxx
  
  xxxxxxx

- **Special Character** is where continued lines are indicated by a special character (otherwise each line is considered a new field), as in:

  AU: xxxxx
  *xxxxxxxx
  *xxxxxxxx

  The special character is not transferred to ProCite as text.

9. Use the pull-down list next to **Case Conversion** to handle upper and lowercase characters during the transfer.

- **No Conversion** transfers text without any changes in case.

- **Upper Case All** changes all text to uppercase.

- **Lower Case All** changes all text to lowercase.

- **Title Case** changes the first character of each word to uppercase, and all other characters to lowercase.

- **Sentence Case** changes the first character of each sentence to uppercase and all other characters to lowercase. It cannot identify proper nouns for capitalization.

**Note:** This setting affects all text transferred. You may prefer to apply case conversion individually for each tagged field. For example, your download file may show most fields with appropriate capitalization. If **Keywords** is the only field displayed all in uppercase, you can apply case conversion only to **Keywords**. This is described in **Chapter 7: Mapping Field Tags to ProCite Fields**.
10. Click **OK** to save your settings.

11. From the **File** menu, select **Save** to save your file to disk.

**Entering Ignored Strings**

Ignored strings are lines of text that appear in your download file but should not transfer into ProCite records. These are typically command prompts from online systems and lines such as:

```
continued on next page....
```

Any line beginning with an ignored string is completely ignored for transfer. Do not use this feature if valuable information appears after the ignored string on the same line.

**To enter text you want ignored during importing:**

1. From the **Configuration** menu, select **Ignored Strings** to display the Ignored Lines dialog.

2. Click **New** to add a new line to the list. The Ignored Line Format String dialog appears.
3. Type the character string in the **Line Format** text box. You can use the special characters, # (any number) and * (any character).

4. Click **OK** to save your entry.

5. Go back to step 2 if you want to enter additional ignored strings.

   To modify or delete a string, select it and click the **Modify** or **Delete** button at the bottom of the screen.

6. Click **Done** to save changes to the Ignored Lines dialog.

7. From the **File** menu, select **Save** to save your file to disk.
Chapter 5
Adding and Configuring Databases

Overview

Some information services offer one large database for searching and retrieving records. Other information services offer multiple databases for record retrieval. Multiple databases, even though from the same information provider, may vary significantly in what field tags are included on output and how field text is formatted. In most cases, you can create one configuration file for the information service, with separate mapping instructions for each database offered by that provider.

You should already have your configuration file set up to recognize the location of database names, records, and field tags in your download files. Now you must add to the configuration file the actual database names you want to recognize.

You can add databases, modify database settings, or delete databases at any time.

The Default Database

If your information provider offers a single database, you can set up a single Default Database. For systems with multiple database offerings, the default database definition may be used when:

• the configuration file is not set up to correctly locate database names in the download file

• a database name appears in the download file, but is not defined in the configuration file

• no database name appears in the download file

You may want to define the Default Database with settings common between most databases offered by the information provider. These common settings are then available when a database name is not avail-
able, and you can copy these common settings when you begin to define a new database.

To define the Default Database settings or settings for a specific database, see the next two sections, *Adding and Mapping Databases* and *Modifying Database Settings*.

### Adding and Mapping Databases

To add provider database names and map them to ProCite workforms:

1. If it is not already open, open your configuration file. The database list screen will display. If this is a new configuration file, only the **Default** database will appear in the list:

   ![Database List Screen](image)

   - **Default**: Default Database Definition, Book Long Form

2. Click the **New** button. The Database Information dialog appears:

   ![Database Information Dialog](image)
3. Type the database name in the **Name** text box (up to 64 characters).

   **Note:** The database name is the name that appears in your download file. ProCite will attempt to match the name found in the download file to the name entered here. While the official database name may be long, such as "Excerpta Medica - Cardiology", you must use the version that appears in your download file, such as "Cardiology".

4. You can enter full database names in the **Description** text box (up to 64 characters). This is text to help you identify the database for editing. For example, the Dialog system uses numbers as database indicators in the download file, so the Description box is used for a text description of the database.

5. Use the **ProCite Workform** pull-down list to select a destination ProCite workform. Records retrieved from the database will transfer into this workform in ProCite.

   **Note:** At this basic level, you can map each database to a single ProCite workform. This works great when an entire database contains one type of record, such as all journal articles or all patents. If the database combines different types of documents, pick the workform that will work for the majority of records. However, if the records include a field that contains a description of the document type, you can later recognize and map those document types to the appropriate ProCite workform. This is described in *Chapter 6: Mapping Records to ProCite Workforms*. 
6. Click **OK** to save the new database settings and display a blank field list:

![Database Settings](image)

7. At this point, you can:

   - Start adding and mapping field tags as described in *Chapter 7: Mapping Field Tags to ProCite Fields*.
   - Click the close box to return to the database list, and continue adding and mapping databases. You can add and map field tags later.

**Note:** As you enter databases, remember to often go to the **File** menu and select **Save**.
Modifying Database Settings

You can modify provider database names and settings at any time.

To modify provider database names and settings:

1. If it is not open already, open your configuration file. The database list screen displays.

   **Note:** If the provider offers a single database, only the Default database appears in the list.

2. Highlight the database you wish to modify.

3. From the Configuration menu, select Database Information to display the Database Information dialog:
4. On the Database Information dialog you can modify:

- The database **Name** that appears in your download file (up to 64 characters). ProCite will attempt to match the name found in the download file to the name entered here.

- The database **Description** (up to 64 characters). This is text to help you identify the database.

- The target **ProCite Workform**. Records retrieved from the database will transfer into this workform in ProCite unless a document type field is present and used for workform selection.

5. Click **OK** to save the new database settings and return to the database list.

6. To edit fields and field mapping (as described in *Chapter 7: Mapping Field Tags to ProCite Fields*), double click on the database you want to modify, or highlight it and click the **Modify** button. The field list appears.

![Field List](image)

**Note**: As you modify database settings, remember to often go to the **File** menu and select **Save**.
Copying Database Settings

Often, the easiest way to set up a new database is to copy the settings from a similar database. When you copy database settings, you copy all settings for that database, such as workform settings, document types with mapping, and field tags with mapping. Then you can make the (hopefully minimal) changes required.

**To copy database settings:**

1. In the database list, find and highlight the database whose settings resemble the settings needed for a new database. This could be the Default database, which may contain settings common to most databases.

2. From the **Edit** menu, choose **Copy** to copy the database settings to the clipboard.

3. From the **Edit** menu, choose **Paste**. A dialog will appear, telling you that database already exists, and asking that you choose a new name for the database.

4. Click **OK** to display the Database Information dialog.

5. On the Database Information dialog,
   a. Enter a new database name and description.
   b. If you need to, change the ProCite workform selection.
   c. Click **OK** to save the settings.

You are returned to the database list, where the new database appears.
Deleting Databases

When you delete a database from a configuration file, all of its database definitions are deleted, including document types and field tags. You cannot delete the Default database.

**To delete a database:**

1. Highlight the database name in a database list.
2. Click **Delete**. ProCite will ask for confirmation before deletion.
3. Click **OK** to permanently delete the database.
Overview

At the most basic level, you can map all records from a single provider database to a single ProCite workform. However, many databases contain various document types; a single database could include references to patents, journal articles, books, and dissertations. If your records include a field indicating document type, you can add the document types to your configuration file and map records to a specific workform in ProCite based on document type.

This chapter explains how to map all records from a provider database to a single ProCite workform, how to define a "document type" field from your download file, and how to enter document type indicators and map them to corresponding ProCite workforms.

Mapping a Database to a ProCite Workform

When you add a new provider database to a configuration file, you select a matching ProCite workform for records from that database.

This is how you can modify the workform setting for a database:

1. In the database list, highlight the database whose settings you wish to change.
2. From the Configuration menu, choose Database Information. The Database Information dialog appears:

3. Use the Workform pull-down list to select a destination ProCite workform. Records retrieved from the database will transfer into this workform in ProCite.

**Tip:** Pick the workform that will work for the majority of records. If the records include a field that contains a description of the document type, you can recognize and map those document types to the appropriate ProCite workform as described later in this chapter.

4. Click OK to save the new setting.

---

**Recognizing the Document Type Field**

In order to use the document type indicators in your records, ProCite first needs to locate them. You need to define which field contains the document type indicators. Look at records in your download file to find the field. The document type field is set up separately for each database from the information service, since even databases offered by the same provider may have different settings.

**Note:** If you do NOT want to use the document type indicators in your records, you can also follow the instructions below to make sure the document type field is NOT flagged as a "Document Type" field. ProCite will then use a single workform for all records from that database.

**To add and/or modify the document type field:**

1. In the database list, double click on the database whose settings you wish to modify. Biblio-Link II displays a list of field tags already defined for the database.
2. Modify or add the document type field tag (often the "DT" or "PT" field).

   - To add the tag, click **New Field**.
   - To modify an existing tag's settings, double click on it. The Field Type column will already show the attribute "Document Type" if the field is already recognized as such.

The Field Information dialog appears:

3. Verify the **Field Tag**, **Description**, and target **ProCite Field**. You most likely do not want to transfer the actual text of the document type field into a ProCite field. In that case, make sure the **ProCite Field** item is set to **Do Not Transfer**.

4. In the Field Attribute section, use the pull-down list to set the **Field Type** option to **Document Type**. When you set the Field Type to Document Type, an Options--Document Type section is added to the dialog.

   **Note:** If you do *not* want document types to determine the ProCite workform, set the **Field Type** to **Normal Text**.

5. If some of the document type fields contain more than one document type indicator, enter the separator in the box titled **Document Types separated by**. For example, this document type field contains two indicators separated by a semicolon:

   PT: Article; Newspaper
6. Click **OK** to save changes to the tag.

7. Click the close box to close the list of fields.

You have added and mapped the document type field itself. The next step is to add the actual document type indicators that appear in the field. Map each indicator to a corresponding ProCite workform as described in the next section.

---

**Adding and Mapping Document Types**

Add and map document type indicators for each database from an information service. Because the various databases originate from different sources, document type indicators vary widely.

The document type indicators you enter must match the text that appears in your download file; ProCite will attempt to match the document type found in the download file to the name entered here. If the download file includes several variations of the same document type, enter and map all variations separately. For example, you may need to add all of these variations and map each one to the *Journal Article* workform in ProCite:

- Journal Article
- Journ Art
- Article

Some databases include more than one document type indicator in a single document type field for a record. In this case, ProCite will use the first indicator encountered and recognized. ProCite would use the Patent indicator from this example:

- DT - Patent; Conference Proceeding

**To add or modify a document type for a database:**

1. In the database list, highlight the database name.

2. From the **Configuration** menu, select **Document Types** to display the current list of recognized document types for that database.
3. Add or modify a document type:
   - To add a document type, click **New**.
   - To modify an existing document type, double-click on it.

   The Edit Document Type dialog appears:

   ![Edit Document Type Dialog](image)

4. In the Edit Document Type dialog:
   a. Make sure the document type indicator entered here matches the text found in your download file.
   b. Use the drop-down list to select the appropriate ProCite workflow for records with this document type indicator.
   c. Click **OK** to save changes, and Biblio-Link II returns you to the Document Types list.
5. At this point, you can:
   
a. Continue adding or modifying document types for this database.
   
b. Click **Done** to return to the database list.

You have added and mapped the actual document type indicators that appear in your download file. If you haven't already, make sure you define the document type field itself, as described under *Recognizing the Document Type Field* earlier in this chapter.

---

**Deleting Document Types**

**To delete a document type:**

1. In the database list, highlight the database you wish to modify.

2. From the **Configuration** menu, select **Document Types** to display the current list for the database.

3. Highlight the document type you wish to delete.

4. Click the **Delete** button.

5. When you are finished modify the list of document types, click **Done** to return to the database list.
Chapter 7

Mapping Field Tags to ProCite Fields

Overview

Each record in your download file is divided into tagged fields. ProCite uses each tag to determine which target ProCite field will receive the information in that field. For example, information tagged with "AU" or "Author" will typically transfer into ProCite's 01 Author, Analytic field.

For each database offered by your information service, you can map each field tag to an appropriate ProCite field. You can also use a "Do Not Transfer" option for fields you do NOT want to transfer into your ProCite records.

This chapter explains how to add field tags to your configuration file and map those tags to corresponding ProCite fields, copy field tag definitions, and delete field tags.

This chapter contains some information about appropriately mapping multiple data fields such as author fields, source fields, and subfields. For complete information about mapping these fields, see the appropriate chapter later in this manual: Chapter 8: Setting the Author Field Format, Chapter 9: Parsing Source Fields, or Chapter 10: Parsing Tagged Subfields.

Adding and Mapping Field Tags

Separate field lists are maintained for each database from an information service. If the service offers a single database of records, you can work with only the Default database. Otherwise, you need to create a field list for each database.

Tip: For fields that are the same between databases, you can set the field up once and then copy that field definition for other databases. See Copying Field Tag Definitions later in this chapter.
To add a field tag or modify a field tag setting:

1. In the database list, double-click a database name to display the field list for that database.

2. Display the Field Information dialog.

   - To add a new tag, click the **New Field** button at the bottom of the dialog.

   - To modify the settings for an existing tag, double click on the field tag.

3. Refer to the next three sections, which describe *Mapping the Field Tag*, *Setting Field Attributes*, and *Setting Field Type Options* from this Field Information dialog.

4. Click **OK** to save changes.

5. Select **Save** from the **File** menu to save changes to disk.
Mapping the Field Tag

Enter basic information at the top of the Field Information dialog:

Field Tag: Enter the field tag as it appears in your download file. For example, "AU" for an author field. You can enter up to 32 characters, so the field tag could actually be a long field name.

Description: Enter a description of the field. This could be a long name provided by your information service, or it could be a note for your own use. You can enter up to 64 characters. Months from now, it may not be as clear that "PD" means "Publication Date," especially since it may have a different meaning in another database, such as "Patent Diagram."

ProCite Field: Use the ProCite Field drop-down list to select the primary target ProCite field. Information from the tagged field will transfer to the ProCite field selected here.

Tip: If you do NOT want to transfer the field text at all, select Do Not Transfer. You can then click OK to save the setting and leave the Field Information dialog.

Target Fields:

If you are transferring all records into a single ProCite workform, you can ignore the Target Fields button and continue to the next section, Setting Field Attributes.

If the configuration file is set up to recognize various document types that will import into different ProCite workforms, you may need to use the Target Fields button to override the primary target field for specific workforms.

For example, you may have mapped an author field to ProCite field 01 Author, Analytic. That works well for most workforms, including Journal Article. However, the Book Short Form workform does not include field 01; you should transfer author names to 07 Author, Monographic for records in the Book Short Form workform.
To override the default target field for a particular workform:

1. Click the **Target Fields** button to display a Target Fields list:

   ![Target Fields](image)

   Each workform is listed along with the current target ProCite field. If you are defining a new tag, all fields are mapped to the primary ProCite Field set up for the tag. The workforms that do not contain that ProCite field list a field number and dashes only (no field name).

2. Double click on a workform to change its target field. The Edit Target Field dialog appears:

   ![Edit Target Field](image)

3. To override the primary target field for this workform, select the **Use alternate target field** button and use the drop-down list to select the new ProCite field.

4. Click **OK** to save changes and return to the Target Fields list.
5. At this point, you can do one of these:
   - Continue overriding the target field for various workforms.
   - Click **Done** to return to the Field Information dialog.

Now, move on to the next section, *Setting Field Attributes*.

## Setting Field Attributes

Field attributes assigned to a tag help ProCite parse (separate) a multi-text field and translate field text into the correct ProCite format.

In the **Attributes** section of the Field Information dialog:

1. Select a **Field Type** from the drop-down list.

   ![Attributes screenshot]

   **Note:** When you select a field type, an additional Options area may appear on the dialog. These options are described in the next section of this chapter, *Setting Field Type Options*.

The field type choices are:

**Normal Text:** Transfer the text to ProCite with no changes in formatting. This is the default setting that typically works for the majority of fields.

**Multi-Text:** The field contains multiple entries that should transfer to the same ProCite field, such as a series of keywords.

**Date:** The field contains a date.

**Parsed:** The field contains multiple source information that should transfer into separate ProCite fields. This field should contain some combination of Journal Title, Volume, Issue, Pages, and/or Date. For
information specifically about parsing source fields, see *Chapter 9: Parsing Source Fields*.

**Parsed with Subfields**: The field contains subfields of information that are each tagged *within* this field. ProCite will look within the field for field tags. For information specifically about parsing with subfields and adding subfield tags, see *Chapter 10: Parsing Tagged Subfields*.

**Document Type**: The field contains a document type identifier, such as "Journal Article" or "Book" that you wish to use to determine the appropriate ProCite workform. For information specifically about using document types to determine ProCite workforms, see *Chapter 6: Mapping Records to ProCite Workforms*.

**Literal Stream**: A field you want to transfer "as is" until another field tag or new record is located in the download file. This is often a "worst case scenario" field. Use this feature when a field includes blank lines or spaces that confuse the transfer (blank lines usually indicate the end of a record, so would split a single record into two), or when other characters confuse ProCite. This field type also lets you transfer chemical equations or diagrams intact.

**Author**: A field that contains author names. ProCite can translate various forms of author names into the appropriate ProCite format. For information specifically about transferring author names, see *Chapter 8: Setting the Author Field Format*.

2. In the **Begins With** box, type text that is always included at the beginning of the field (up to 20 characters) that should be ignored. Most information services do not include this text, in which case you would leave the box empty. In this example, "AU" is the field tag and
"Author:" is the "Begins With" text:

   AU - Author: Smith, John

3. In the Ends With box, type text that marks the end of the field (up to 20 characters). Most information services do not include such text, in which case you would leave the box empty. Dialog often uses a vertical bar at the end of fields (|); you would enter it here to strip it from the end of the field so it does not transfer to ProCite.

4. **Case Conversion** handles translation of upper and lowercase characters. The download file is not changed, but the text is modified for import into ProCite.

   - **Default**: Uses the default setting for case conversion. This is set on the Field Identification dialog (from the Configure menu) for all records in the download file.
   - **No Conversion**: Text imports into ProCite without any changes to upper or lowercase characters.
   - **Upper Case**: All text in the field is converted to upper case during import.
   - **Lower Case**: All text is lowercased during import.
   - **Title Case**: The first letter of each word is capitalized.
   - **Sentence Case**: The first letter of each sentence is capitalized (proper nouns are not recognized as such).

5. In the **Space Character** box, type the character used to designate a blank space. For example, hyphens may represent spaces in the field. Most services do not signify spaces with a different character, in which case you would leave this blank.

6. Select or deselect the **Compress Multiple Spaces** checkbox. When selected, ProCite will replace multiple spaces with a single space.

7. If the **Field Type** you selected caused an additional Options section to appear on the dialog, see the next section, *Setting Field Type Options*. Otherwise, you can click **OK** to save the current field tag settings and return to the field list.
Setting Field Type Options

Depending on the Field Type attribute selected, an additional Options area may appear on the Field Information dialog. If the field type is Date or Literal Stream, no additional options appear. Field options for the other field types are described in the following sections: Normal Text Options, Multi-Text Options, Parsed Options, Parsed with Subfields Options, Document Type Options, and Author Options.

Normal Text Options

For normal text, you need to indicate how carriage returns within a field should transfer into ProCite. For systems that never include carriage returns within a field, these settings are irrelevant.

Select one of these buttons for Replace Carriage Return with:

**Space:** Each carriage return gets replaced with a space. This is the default setting, and works well for services that end each line of text with a carriage return.

**New Line:** Each carriage return transfers as though you had entered a carriage return in ProCite.

**Character:** Each carriage return is translated into the character you enter in the adjacent text box.
Select one of these buttons for **Carriage Return represented by**:

**Carriage Return**: The information service uses a normal carriage return. When you display invisible characters, it shows up as the standard paragraph symbol.

**Character**: The information service indicates a carriage return with the character you enter into the adjacent text box. For example, Dialog often uses a caret (^) to indicate carriage returns within a field.

**Multi-Text Options**

When a field contains multiple entries, such as a series of keywords, you must indicate the character that separates each component.

For example, a keyword field may appear in your download file as:

```
```

You would enter a period and space as the separator. When transferred into ProCite's **45 Keywords** field, ProCite would replace the separator with the appropriate ProCite separator:

```
Keywords (45): Allergic-Asthma/House Dust/Mite/Lung Function
```
Parsed Options

When ProCite parses a Source field, you need to indicate target fields in order to send the Journal Title, Volume, Issue, Pages, Date, ISSN and/or CODEN to the appropriate ProCite fields.

To send source information to the appropriate target fields:

1. Next to Title, click Select to display the Auto-Parsed Target Fields dialog:

This dialog lists the target field for each workform—in this case, where the title will appear in the ProCite record. Since parsed fields appear primarily in journal entries, make sure the field is mapped appropriately for each of the journal workforms.
If all of your records are transferring into one workform type, you need to set the appropriate target field only for that workform. For example, if all of your records are transferring to the *Journal Long Form* workform, make sure the title is transferring to field *10: Journal Title* for that workform.

**Tip:** Appendix B: *ProCite Workforms and Fields* lists the predefined workforms and their included fields.

**Tip:** If a tag is mapped to field *09 Title, Monographic* and the destination workform does not include that field, ProCite will attempt to send the text to field *10 Journal Title*. This accommodates the Journal Title field number change between ProCite 3 and ProCite 4.

2. To change a target field for a particular workform, double-click on that line to display:

![Edit Auto-Parsed Target Field](image)

3. Use the drop-down list to select the appropriate ProCite field and click **OK** to save the change.

4. You can continue changing the target field for each workform, double-clicking on each line you wish to modify.

5. When you are done setting target fields for this parsed component, click **Done**.

4. Go back to step 1, making sure each parsed component (*Title, Volume, Issue, Pages, Date, ISSN*, and *CODEN*) is mapped to the appropriate ProCite field by workform.
Parsed with Subfields Options

The field type Parsed with Subfields displays options for identifying subfield tags. Enter the characters that surround subfield tags. The Subfield Tags begin with item is optional, but you must enter something in the and are followed by box. For this example,

SO- <PY> 1998 <VO> 25

you would enter "<" in the first text box and ">" in the second text box to identify the subfields PY and VO.

Note: You need to map the individual subfields as described in Chapter 10: Parsing Tagged Subfields.

Document Type Options

When a document type field contains multiple document types, you must indicate the separator or ProCite will look at the entire field as a single document type indicator.
For example, this is a common document type field:

DT: Article; Conference Proceeding

You would enter a semicolon and space as the separator. ProCite would use only the first document type (Article) in determining the appropriate workform.

**Author Options**

Personal author names translate to the appropriate ProCite format during the Import process. If the author field you are transferring contains only corporate author names (companies, educational institutions, and government agencies), select the **Corporate Author** box so ProCite will not attempt to manipulate the name.

---

**Copying Field Tag Definitions**

Each database in a configuration file has a separate list of field tags with field mapping. However, there may be fields that are formatted exactly the same from each database. Rather than enter and define each of these field tags separately, you can enter a field for one database and then copy that field and field definition for other databases.

**Tip:** You can copy a field to another database in the existing configuration file or to a database in a different configuration file.

**To copy a field tag definition:**

1. In a database list, double click on a database name to display the field list for that database.
2. Highlight the field you wish to copy.

3. From the **Edit** menu, select **Copy**.

4. Close the field list.

5. In a database list, whether in the same configuration file or a different configuration file, double click the database to which you want to add the field.

6. From the **File** menu, select **Paste**. The field tag and definition is pasted for that database.

---

**Deleting Field Tags**

These are situations where you might want to delete a field tag:

- The information system no longer includes that field in download files. While you can leave the field tag without affecting data transfer, it may be confusing.

- You are starting a new configuration file by copying an existing configuration file. Delete those tags that aren't used by the new system to clear a cluttered field list.

**To delete a field tag and its definition:**

1. In the database list, double click on the database you wish to modify.

2. In the field list, highlight the field tag you wish to delete.

3. Click the **Delete** button.
Chapter 8
Setting the Author Field Format

Overview

To search by author and correctly format author names on output, ProCite requires that author names transfer into ProCite Author fields, and that those names appear in a specific format. ProCite can use the configuration file to translate author names into the appropriate format.

You need to map fields containing author names to the appropriate author fields in ProCite, and you need to indicate what form those names are in so ProCite can translate them during import.

This chapter tells you how to define the author field format for each provider database and how to map author information to the appropriate ProCite fields.

Setting the Author Format for the Database

You can set a unique author format for each database or use the format set up for the Default database.

• If the information service provides a single database, just set the format for the Default database.

• If most of the databases from the information provider present author names the same way, you can set the appropriate format up for the Default database and then, for those databases that use the same format, indicate that they should use the Default database format for author names.

• If each database retrieves author names in a different way, you need to set up an author format for each one.
Examining the Author Fields

Examine your download files to determine the author format for each database. If author names all appear in the same format, you can set up a single author format for the default database and use that setting for all databases. You can set a different author format for individual databases, and you may need to do this if your information service provides databases from many different sources.

Determine the order of information and the punctuation in the author fields for records from each database. In this example,

AU: Guglich E A. Wilson P J. White B N.

The information you need includes:

• Author names are presented with surnames first.
• Surnames are separated from initials by a space.
• Author names are separated by a period and a space.

Using the Default Database Setting

If many (or all) databases from a single information provider present author names the same way, you can set up a single default format to use for those databases.

To select a default author format for all databases:

1. In the database list of your open configuration file, highlight Default.
2. From the Configuration menu, select Author Field Format.
3. If the Default database setting matches what you need for another database, click **Cancel** to return to the database list.

   If you want to modify the Default setting, see the next section, *Setting an Author Format*.

4. For a database that uses the same author format as the Default, highlight the database name in the list.

5. From the **Configuration** menu, select **Author Field Format**.

6. Check the **Use Default Database's Format** box at the top of the dialog and click **OK** to save.

   If you want to change the default database setting, or set up a custom author format for another database, go to the section below, *Setting an*
Author Format..

Setting an Author Format

To set up or modify an author format:

1. Determine the layout of author names in your download files as described in Examining the Author Fields earlier in this chapter.

2. In the database list of your open configuration file, highlight the database whose author format you wish to define. You can select any individual database, including the Default.

3. From the Configuration menu, select Author Field Format to display the current author format for the highlighted database.

4. If it is selected, deselect the Use Default Database's Format box.

5. Toward the bottom of the dialog, select or deselect the Spaces are represented by hyphens box. This item either shows or removes hyphens from the author names on the dialog.

6. Click a radio button to select the author format that most closely matches the author names in the download file.

7. At the bottom of the dialog, enter the character(s) that separate individual author names. When author names transfer into ProCite, this item translates into the ProCite author separator (//). The most common separator is a semicolon and space.
Adding the Tag as an Author Field

Even though you may have an author format set up for a database (as described in the previous section), ProCite cannot use that information until a tagged field is assigned the field type "Author."

1. In the database list, double click on the database you wish to modify.

2. Open the field tag for the field that contains author names. Author fields are typically tagged with AU, Author, Authors, or Name, but it could have a unique tag.
   - If it is already in the field list, double click on it.
   - If it is not in the field list, click New Field.

3. Verify (or type in) the Field Tag and Description.

4. For ProCite Field, select the target ProCite author field. In most cases, you should transfer author names to either 01 Author, Analytic or 07 Author, Monographic.

5. Under the Attributes section, set the Field Type to Author. This tells ProCite to translate author names using the Author Field Format. Setting the Field Type to Author adds an additional Options--Author section to the dialog.
6. Under Options--Author, either select or deselect the **Corporate Author** box. Select the box if author names in the download file are primarily companies, universities or government agencies; ProCite will not attempt to translate such names into the personal author format.

7. Click **OK** on the Field Information dialog to return to the database list.

8. Remember to **Save** changes from the **File** menu before you continue modifying the configuration file.
Overview

When a tagged field contains a single type of information, such as a title, it is easy to direct that field to a single corresponding ProCite field. However, it is common to retrieve a single Source field that contains a combination of title, volume, issue, pages, date, ISSN and/or CODEN as in this example:


You need ProCite to parse (separate) each component and send each component to the appropriate ProCite field. To do this, you need to:

• Set up a parsing format for the database, which indicates the order of the components and the punctuation used to separate them.

• Add the field tag, indicate the field type "parsed," and map each component to an appropriate ProCite field.

Note: This method of parsing a source field is necessary when source information is separated only by punctuation. If the field contains embedded field tags, see Chapter 10: Parsing Tagged Subfields.

Setting a Parsed Format for the Database

You can set a unique parsing format for each database or use the format set up for the default database.

• If the information service provides a single database, you can set everything up under the Default database.
• If most of the databases from the information service present the source information the same way, you can set the appropriate format up for the Default database and then, for other databases, indicate that they should use the Default database format for parsing.

• If each database retrieves source information in a different format, you need to set up a parsing format for each one.

**Note:** Each database can recognize a single parsing format; if more than one format is used for records from a single database, use the most common form. Those records whose source fields do not use the most common parsing format will require editing after transferring into ProCite.

---

**Examining Your Download Files**

To determine the best way to parse source information, you need to examine your download files. For each database, look at source fields from many records. Hopefully they all appear in the same format; if not, choose the most common format. You can set a single parsing format for each database.

Determine the order of information and what punctuation or text separates each item of information.

In this example,

```
```

you can see that:

• five fields are presented in this order: journal title, volume, issue, pages, date

• a period and space separates the journal title and volume

• a left parentheses separates volume and issue

• a right parentheses and colon separates issue and pages

• a comma and space separates pages from date

This specific information will help you define an accurate parsing format.
Using the Default Database Settings

If many databases from a single information provider present source information the same way, you can set up a single default parsing format to use for those databases.

To set up a default parsing format:

1. In the database list of your open configuration file, highlight Default.

2. From the Configuration menu, select Parsed Field Format.
The Example box at the bottom of the dialog shows the current settings for the Default database.

3. If the default database settings match what you need for another database, click Cancel to return to the database list.

4. For a database that uses the same source field format as the Default, highlight the database name in the list.

5. From the Configuration menu, select Parsed Field Format.

6. Check the Use Default Database's Format box at the top of the dialog and click OK to save.

If you want to change the default database settings, or set up a custom parsing format for another database, go to the next section, Setting a Parsed Field Format.
Setting a Parsed Field Format

To set up or modify a parsing format:

1. Determine the layout of your source fields as described in *Examining Your Download Files* earlier in this chapter.

2. In the database list of your open configuration file, highlight the database whose parsing format you wish to define. You can select any individual database, including the Default.

3. From the **Configuration** menu, select **Parsed Field Format** to display the current parsing format for the highlighted database.

4. Deselect the **Use Default Database's Format** box to set up a custom format by entering specific parsing instructions. As you make changes, they are reflected in the example at the bottom of the dialog.

5. Under **Component**, use the pull-down lists to list the order in which items appear in your source fields. If there are fewer than seven components in your source fields, set the last items(s) to **None**.

**Tip:** If a field appears in most records, but not in others, you should still include it here. For example, some records may contain title, date, volume, and issue, while others may include only title and date. You would list all four fields.
6. If a component does not always appear in the source field, check the **Optional** box next to that field. In the example mentioned in the Tip above, volume and issue are optional fields. If they appear, ProCite will parse them; if they don't appear the parsing information for those fields is ignored.

7. In the **Preceded By** and **Followed By** text boxes, enter the text and/or punctuation that separates each bit of information. In this example,


these settings work well to parse each item:

![Parsed Field Format for DB 'DEFAULT'](image)

These settings are rather subjective, since punctuation can be entered as either ending text for one field or preceding text for the next field. It is not always clear which will work best for ProCite, and you may need to return here to make modifications later.
Tips:

• When entering preceding and ending text for optional fields, make sure you include only punctuation that appears or disappears depending on whether the field is present.

• You can use an asterisk "*" as a wild card in preceding text, meaning that any text is acceptable. For example, you could use "*." as preceding text before the first component to get rid of extraneous characters (that end with a period) before the source information.

• You can use a backslash-r (\r) to indicate a line break after a component.

8. To save changes to the parsing format for the current database, click OK to return to the database list.

Adding the Tag as a Parsed Field

Even though you may have a parsed format set up for a database (as described in the previous section), ProCite cannot use that information until a tagged field is assigned the field type "Parsed."

1. In the database list, double click on the database you wish to modify.

2. Open the field tag for the field you want to parse. In most cases, this is a field tagged with SO, Source, or JN.

   • If it is already in the field list, double click on it.

   • If it is not in the field list, click New Field.

3. Verify (or type in) the Field Tag and Description.

4. For ProCite Field, enter the field you want used if ProCite cannot parse the information. In most cases, this is the 10 Journal Title field.
5. Under the Attributes section, set the **Field Type** to **Parsed**. This adds an additional Options--Auto-Parsed section to the dialog.

![Field Information dialog](image)

6. Under Options--Auto-Parsed, you need to indicate target fields in order to send each title, volume, issue, page number, date, ISSN, and CODEN to the appropriate ProCite field.

   a. For each component, click **Select** to display the Auto-Parsed Target Field dialog:

![Auto Parsed Target Fields](image)

   This dialog lists the target field for each workform. Since source fields appear primarily in journal entries, make sure the field is mapped appropriately for each of the journal workforms.
If all of your records are transferring into one workform type, you need to set the appropriate target field only for that workform. For example, if all of your records are transferring to the *Journal Long Form* workform, make sure the title is transferring to field 10: *Journal Title* for that workform.

**Tip:** Appendix B: *ProCite Workforms and Fields* lists each of the predefined workforms.

b. If you need to change the target field for a workform, double-click on the line to display:

![Edit Auto-Parsed Target Field](image)

Use the drop-down list to select the appropriate ProCite field and click **OK** to save the change.

You can change target fields for each workform, double-clicking on each line you wish to modify.

c. When you are done setting target fields for a parsed component, click **Done**.

Make sure each parsed component is mapped to the appropriate ProCite field by workform.

7. Click **OK** on the Field Information dialog to return to the database list.

8. Remember to **Save** changes from the **File** menu before you continue modifying the configuration file.
Chapter 10
Parsing Tagged Subfields

Overview

In most cases, each tagged field in a download file transfers to a single corresponding ProCite field. However, some information systems embed tagged information *within* a tagged field, as in these examples:

- **JN** - `<VO>` 14 `<IS>` 3 `<DT>` January 1998

You will want to parse (separate) the field and direct each subfield to an appropriate ProCite field. To do this:

- Indicate that the primary tag (the tag at the left margin) is the field type "Parsed with Subfields."
- Add and map the subfield tags that appear within the field.

Adding the "Parsed with Subfields" Tag

To parse a field that contains subfields, you must first either add or modify the primary tag.

**To add or modify the primary tag:**

1. In the database list, double click on the database you wish to modify.
2. Create or open the field tag for the field you need to parse (the field that contains subfields):
   - If it is already in the field list, double click on it.
   - If it is not in the field list, click New Field.
3. Verify (or type in) the Field Tag and Description.
4. For **ProCite Field**, select **Do Not Transfer**.

5. Under the Attributes section, set the **Field Type** to **Parsed with Subfields**. This adds an additional Options--Subfields section to the dialog.

6. Enter the surrounding text that pinpoints the subfield tags.

   a. In the **Subfield Tags begin with** box, enter the character or string that appears before each subfield tag. This item is optional; some systems follow a subfield tag with a colon or other character, and do not use a starting character.

   b. In the **and are followed by** box, enter the character or string that follows each subfield tag. You must enter at least one character in this box to help ProCite locate the subfield tags.

For the following example, you would enter "<" in the first text box and "> " in the second text box to identify the subfields "VO," "IS," and "DT".

```
JN - <VO> 14 <IS> 3 <DT> January 1998
```
For the next example, you would enter nothing in the first text box, and ": " in the second text box to identify the subfields "MAJOR" and "MINOR."

**DE - MAJOR:** Asthma. Allergy. Immunology. **MINOR:** Homeopathic Treatments. Bee Pollen. Asthma Medications.

7. Click OK to save changes and return to the field list.

Now, you must map the individual subfields as described next.

---

### Adding and Mapping the Subfield Tags

Before you can add subfields to your configuration file, you must first enter the primary tag and flag it as "Parsed with Subfields." This is described in the previous section.

Add each subfield that may appear within a single tagged field. The subfields can appear in any order within the field.

1. On the database field list, highlight the tag that contains subfields and click the Add Subfield button. The Field Information dialog appears:

   ![Field Information Dialog](image)

2. A subfield is treated the same as any other field. Apply the Field Information settings as needed specifically for the subfield text. If you need help with these settings, see *Chapter 7: Mapping Field Tags to ProCite Fields.*
3. Click **OK** to save changes and return to the field list. The subfield appears indented in the field list under the primary tag.

![Database Field List](image)

**Note:** As you add tags and subfield tags, remember to periodically select **Save** from the **File** menu to save your changes to disk.

If the parsed field includes text before a subfield tag appears, you can add a "null subfield" to map that initial text in the field.

**To add a null subfield:**

1. On the database field list, highlight the tag that contains subfields and click the **Add Subfield** button to display the Field Information dialog.
2. Leave the **Field Tag** area blank, and enter **Null Subfield** as the Description.

![Field Information dialog box](image)

3. Map to the appropriate ProCite field (or *Do Not Transfer*), and apply the other Field Information settings as needed for the text. If you need help with these settings, see *Chapter 7: Mapping Field Tags to ProCite Fields*.

4. Click **OK** and the null subfield appears in the field list.
Overview

You can open a configuration file and print a report listing the configuration file settings. You select the information to include in the report, so it can be short or as detailed as you wish.

If your configuration file is large and you include field details to print, your report could contain hundreds of pages. Because of this, Biblio-Link II prints reports to a text file. You can then open the file to look at it with a word processor and print it to a printer from your word processor if you wish.

Printing Settings

To print a report of the settings in a configuration file:

1. Open the configuration file with Biblio-Link II if it is not already open. From the Configuration menu, select Open Configuration to display a file dialog. Locate and open the configuration file.

2. From the File menu, select Print Report. The Configuration Report Preferences screen appears:
3. Under **Contents**, select those items to include in the report:

- **DL File Structure** includes the download file structure information, listing the database designators (prefix and suffix character strings).

- **Database List** includes a list of all databases included in the configuration file.

- **Database Details** includes the database ID and description for each database plus the target ProCite workflow to use for records from each database. You can also include the following:
  
  * **Database Field List** includes a list of all fields defined for each database, with the field tag, description, and target (ProCite) field for each.
  * **Auto-Parse Formats** includes the automatic parsing format for each database.
  * **Field Details** includes, for each defined field for each database, the field tag, description, field type, default target field, space character, whether to compress spaces, whether to do case conversion, and the beginning and ending character strings. It also lists field attribute options, which depend on the field type.

  **Note:** Large configuration files have many field details. Your report could contain hundreds of pages!

4. Click **OK** to accept your settings and display a **Save As** dialog.

5. Enter a name for the file, locate an appropriate folder to place it, and click **Save** to write your configuration file report to disk.

6. Open the new text file with your word processor.

   When you open the report with your word processor, you may need to adjust tabs to line up columns.

   You can print the report from your word processor to a printer as you would any text document.
Appendix A

Troubleshooting

This appendix describes situations you may encounter while setting up a configuration file or while importing records into ProCite with a configuration file.

I can't open a download file with Biblio-Link II

You cannot open a download file with Biblio-Link II. Use Biblio-Link II to edit configuration files, and use ProCite to open download files and import records. While earlier versions of Biblio-Link II actually transferred records, that functionality is now included in ProCite. In ProCite, use the Tools menu to Import Text File.

ProCite imported nothing from the download file

First, make sure the download file is an ASCII text file. Display it with ProCite (choose Import Text File from the Tools menu and open the download file). If you see odd characters or strange formatting, the file is not ASCII text. You must download to an ASCII file. Once the file is downloaded, you can view it with a word processor — but do not save it as a word processor document. Once you do that, it is no longer an ASCII text file.

Are you using the correct configuration file? For example, the Medline database is offered by several information providers (Medlars, SilverPlatter, etc.). Each provider may retrieve the same records in a slightly different format, so using the appropriate configuration file is critical.

If the download file is an ASCII file and you are using the correct configuration file, ProCite either is not identifying the beginning of each record or the beginning of fields. You need to tell ProCite how to identify the beginning of each record, and how to determine the beginning of a new field. Then, you need to add and map field tags. See Chapter 4: Locating Databases, Records, and Fields for more information.
One or more fields does not import

In the configuration file, double click on the database name and make sure each field is included and mapped to a corresponding ProCite field. Map to fields that are included in the target workform. Make sure the fields you want are not mapped to *Do Not Transfer*. See *Chapter 7: Mapping Field Tags to ProCite Fields* for complete information.

Only the first line of each field imports

You need to set the appropriate line continuation option in the configuration file. In your download file, do the second and subsequent lines of a field start at the left margin or are they indented? From the Configuration menu, select Field Identification. Most likely, you need to set Line Continuation to Indented.

The entire download file imported into a single ProCite record

ProCite most likely used the first field tag to determine that there was a record at all. You need to specify how to identify the beginning of each new record, and possibly how to identify the end of each record. Find something unique that starts each record; it may be a number or a consistent string of text or field tag. See *Chapter 4: Locating Databases, Records, and Fields*. Then, make sure all the field tags have been added and mapped for this database.

ProCite imports fields I do not want

In the configuration file, double click on the database name and make sure the fields you do not want are listed and mapped to *Do Not Transfer*. 
Author names are not transferring correctly

First, make sure the author field(s) for this database are assigned the field type Author.

Then, set the appropriate author field format for the database. Highlight the database name, then go to the Configuration menu and select Author Field Format. Select the author format and separator that matches author names in the download file. See Chapter 8: Setting the Author Field Format for more information.

If an author field uses commas both as part of an author's name and to separate multiple author names, Biblio-Link II may not be able to appropriately translate. In this example,

   Jones, Robert, Smith, William, Brown, Randolph

Biblio-Link cannot distinguish the beginning of each new author name. You should change the author field type to Normal and then edit the author fields after transferring into ProCite.

The Source (or SO or JN) field transfers into a single ProCite field or Not all components of the source field transfer correctly

First, make sure the source field for this database is assigned the field type Parsed. While on the Field Information dialog, make sure each component of the source field is mapped to an appropriate ProCite field.

Then, check the parsing format set up for this database. Highlight the database name, then go to the Configuration menu and select Parsed Field Format. The fields must be listed in the order found in the source field. Preceding and following punctuation must match the punctuation separating each bit of information in the source field. Every separating character is significant, including spaces.

Setting the parsed field format can be tricky. You may need to experiment putting punctuation as either following text for an item or as preceding text for the next item. You may also need to experiment assigning Optional fields.
If the source field does not have unique punctuation between items, it may be impossible to accurately parse each item. For example, when each item is separated by a space:

Liberal Education 73 Nov 1987 21-25

ProCite cannot tell where one item ends and another begins—especially when the included fields change between records. You may need to transfer into a single ProCite field and then edit your records.

*Chapter 9: Parsing Source Fields* has complete information about parsing source fields.

### How do I import different document types into various ProCite workforms?

If each record contains a field that indicates document type, you can transfer each into the appropriate workform. First determine which database the records are from; you set up document types by database. For the field that contains the document type (usually the PT or DT field) set the **Field Type** to **Document Type**. Then, you need to add and map the actual document types that appear in the field. See *Chapter 6: Mapping Records to ProCite Workforms* for complete information.

Some bibliographic systems do not include a document type field in downloaded records. In this case, the best you can do is map all records from the database to a single ProCite workform. Pick the workform that matches the majority of records. Once the records are in ProCite, you can manually change workforms.

In either case, ProCite needs to identify the appropriate source database in order to use the settings specific to that database. See *Chapter 4: Locating Databases, Records, and Fields*. 
Appendix B

ProCite Workforms and Fields

Overview

This appendix lists the fields included in each of the workforms supplied with ProCite, and then a list of all 45 ProCite fields. Field names can change from workform to workform, but field numbers remain constant for importing purposes.

Each record in a database uses a single ProCite workform. Each workform makes use of a subset of the 45 fields available in ProCite. The workforms listed here are included with ProCite. You may have modified some workforms, and you may have other custom workforms available.

Supplied Workforms

Abstract
Art Work
Audiovisual Material
Bill-Resolution
Book Chapter
Book Long Form
Book Short Form
Book Whole
Case
Computer Program
Conference Proceedings
Data File
Dissertation
Electronic Citation
Email
Generic
Hearing
In Press
Journal Article
Journal Long Form
Journal Short Form
Journal Whole
Letter
Magazine Article
Manuscript
Map
Monograph
Motion Picture
Music Score
Newspaper
Patent
Report
Sound Recording
Statute
Trade Catalog
Unenacted Bill-Resolution
Unpublished Work
Video Recording
Web Page
### Abstract
1. Author(s)
2. 
3. 
4. Title
5. 
6. 
7. 
8. 
9. 
10. Journal Title
11. 
12. Reprint Status
13. 
14. 
15. 
16. 
17. 
18. 
19. 
20. Date of Publication
21. 
22. Volume ID
23. 
24. Issue ID
25. Page(s)
26. 
27. 
28. 
29. 
30. 
31. 
32. 
33. 
34. 
35. 
36. 
37. Address/Availability
38. Location/URL
39. 
40. 
41. 
42. Notes
43. Abstract
44. Call Number
45. Keywords

### Art Work
1. Artist
2. Artist Role
3. 
4. Title/Subject
5. Medium
6. Connective Phrase
7. Author, Monographic
8. Author Role
9. Title, Monographic
10. 
11. 
12. Reprint Status
13. 
14. 
15. Edition
16. 
17. 
18. Place of Publication
19. Publisher Name
20. Date of Publication
21. 
22. Volume ID
23. 
24. 
25. Location in Work
26. 
27. 
28. Size
29. 
30. 
31. 
32. Series Title
33. 
34. 
35. 
36. Connective Phrase
37. Address/Availability
38. Location/URL
39. 
40. 
41. Notes
42. Abstract
43. Call Number
44. Keywords

### Audiovisual Material
1. Author, Analytic
2. Author Role
3. 
4. Title, Analytic
5. Medium Designator
6. Connective Phrase
7. Author, Monographic
8. Author Role
9. Title, Monographic
10. 
11. 
12. Reprint Status
13. 
14. 
15. Edition
16. Author, Subsidiary
17. Author Role
18. Place of Publication
19. Publisher Name
20. Date of Publication
21. 
22. Volume ID
23. 
24. 
25. Location in Work
26. Extent of Work
27. Packaging Method
28. Size
29. 
30. Series Editor
31. Series Editor Role
32. Series Title
33. 
34. Series Volume ID
35. 
36. Connective Phrase
37. Address/Availability
38. Location/URL
39. 
40. 
41. ISBN
42. Notes
43. Abstract
44. Call Number
45. Keywords
<table>
<thead>
<tr>
<th><strong>Bill-Resolution</strong></th>
<th><strong>Book Chapter</strong></th>
<th><strong>Book Long Form</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Author(s)</td>
<td>1 Author, Analytic</td>
<td>1 Author, Analytic</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 ———</td>
<td>2 Author Role</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 ———</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 Act Title</td>
<td>4 Title, Analytic</td>
<td>4 Title, Analytic</td>
</tr>
<tr>
<td>5 ———</td>
<td>5 Medium Designator</td>
<td>5 Medium Designator</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 Connective Phrase</td>
<td>6 Connective Phrase</td>
</tr>
<tr>
<td>7 ———</td>
<td>7 Author, Monographic</td>
<td>7 Author, Monographic</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 Author Role</td>
<td>8 Author Role</td>
</tr>
<tr>
<td>9 ———</td>
<td>9 Title, Monographic</td>
<td>9 Title, Monographic</td>
</tr>
<tr>
<td>10 ———</td>
<td>10 ———</td>
<td>10 ———</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 Edition</td>
<td>15 Edition</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 ———</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 ———</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 Code</td>
<td>18 Place of Publication</td>
<td>18 Place of Publication</td>
</tr>
<tr>
<td>19 ———</td>
<td>19 Publisher Name</td>
<td>19 Publisher Name</td>
</tr>
<tr>
<td>20 Date of Code</td>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 Date</td>
<td>21 ———</td>
<td>21 Date of Copyright</td>
</tr>
<tr>
<td>22 Bill/Res Number</td>
<td>22 Volume ID</td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 ———</td>
<td>24 Issue ID</td>
<td>24 Issue ID</td>
</tr>
<tr>
<td>25 Section(s)</td>
<td>25 Page(s)</td>
<td>25 Page(s)</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 ———</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 ———</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 History</td>
<td>32 ———</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 ———</td>
<td>36 Connective Phrase</td>
<td>36 Connective Phrase</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ———</td>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Book Short Form</td>
<td>Book Whole</td>
<td>Case</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
<td>------</td>
</tr>
<tr>
<td>1 ———</td>
<td>1 ———</td>
<td>1 Counsel</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 ———</td>
<td>2 ———</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 ———</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 ———</td>
<td>4 ———</td>
<td>4 Case Name</td>
</tr>
<tr>
<td>5 ———</td>
<td>5 ———</td>
<td>5 ———</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 ———</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 Author, Monographic</td>
<td>7 Author, Monographic</td>
<td>7 ———</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 Author Role</td>
<td>8 ———</td>
</tr>
<tr>
<td>9 Title, Monographic</td>
<td>9 Title, Monographic</td>
<td>9 Case Name (Abbrev)</td>
</tr>
<tr>
<td>10 ———</td>
<td>10 ———</td>
<td>10 ———</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 Translated Title</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 Edition</td>
<td>15 ———</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 Author, Subsidiary</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 Author Role</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 Place of Publication</td>
<td>18 Place of Publication</td>
<td>18 ———</td>
</tr>
<tr>
<td>19 Publisher Name</td>
<td>19 Publisher Name</td>
<td>19 ———</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Date of Publication</td>
<td>20 ———</td>
</tr>
<tr>
<td>21 ———</td>
<td>21 Original Pub Date</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 ———</td>
<td>22 Volume ID</td>
<td>22 ———</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 ———</td>
<td>24 ———</td>
<td>24 ———</td>
</tr>
<tr>
<td>25 ———</td>
<td>25 ———</td>
<td>25 ———</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 Extent of Work</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 Packaging Method</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 Series Editor</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 Series Editor Role</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 ———</td>
<td>32 Series Title</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 Series Volume ID</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 ———</td>
<td>36 ———</td>
<td>36 ———</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ———</td>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ISBN</td>
<td>41 ISBN</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 ———</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 ———</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 ———</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
<tr>
<td>Computer Program</td>
<td>Conference Proceeding</td>
<td>Data File</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------</td>
<td>----------</td>
</tr>
<tr>
<td>1. Program Title</td>
<td>1. Author, Analytic</td>
<td>1.</td>
</tr>
<tr>
<td>5. Author Role</td>
<td>5. Medium Designator</td>
<td>5.</td>
</tr>
<tr>
<td>10. Publisher Name</td>
<td>10. Date of Meeting</td>
<td>10.</td>
</tr>
<tr>
<td>11. Date of Publication</td>
<td>11. Place of Meeting</td>
<td>11.</td>
</tr>
<tr>
<td>12. Date of Copyright</td>
<td>12. Date of Meeting</td>
<td>12.</td>
</tr>
<tr>
<td>15. Extent of Work</td>
<td>15. Place of Meeting</td>
<td>15.</td>
</tr>
<tr>
<td>17. Series Title</td>
<td>17. Place of Meeting</td>
<td>17.</td>
</tr>
<tr>
<td>19. Series Editor Role</td>
<td>19. Publisher Name</td>
<td>19.</td>
</tr>
<tr>
<td>27. Series Editor Role</td>
<td>27. Connective Phrase</td>
<td>27.</td>
</tr>
<tr>
<td>32. Location/URL</td>
<td>32. Connective Phrase</td>
<td>32.</td>
</tr>
<tr>
<td>34. Connective Phrase</td>
<td>34. Connective Phrase</td>
<td>34.</td>
</tr>
<tr>
<td>41. Connective Phrase</td>
<td>41. Connective Phrase</td>
<td>41.</td>
</tr>
<tr>
<td>42. Connective Phrase</td>
<td>42. Connective Phrase</td>
<td>42.</td>
</tr>
<tr>
<td>43. Connective Phrase</td>
<td>43. Connective Phrase</td>
<td>43.</td>
</tr>
<tr>
<td>44. Connective Phrase</td>
<td>44. Connective Phrase</td>
<td>44.</td>
</tr>
<tr>
<td>45. Connective Phrase</td>
<td>45. Connective Phrase</td>
<td>45.</td>
</tr>
<tr>
<td><strong>Dissertation</strong></td>
<td><strong>Electronic Citation</strong></td>
<td><strong>Email</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>1 Author, Analytic</td>
<td>1 Author(s)</td>
<td>1 Author(s)</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 ———</td>
<td>2 Author E-mail</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 ———</td>
<td>3 Author Affiliation</td>
</tr>
<tr>
<td>4 Title, Analytic</td>
<td>4 Title</td>
<td>4 Subject</td>
</tr>
<tr>
<td>5 Medium Designator</td>
<td>5 Medium</td>
<td>5 ———</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 ———</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 ———</td>
<td>7 Editors</td>
<td>7 Recipient</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 ———</td>
<td>8 Recipient E-mail</td>
</tr>
<tr>
<td>9 ———</td>
<td>9 ———</td>
<td>9 ———</td>
</tr>
<tr>
<td>10 ———</td>
<td>10 Source</td>
<td>10 ———</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 Edition</td>
<td>15 ———</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 ———</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 ———</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 Place of Publication</td>
<td>18 Publisher Name</td>
<td>18 ———</td>
</tr>
<tr>
<td>19 University</td>
<td>19 Publisher Name</td>
<td>19 ———</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Last Update</td>
<td>20 Date of Message</td>
</tr>
<tr>
<td>21 Date of Copyright</td>
<td>21 Access Date</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 ———</td>
<td>22 Volume ID</td>
<td>22 ———</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 ———</td>
<td>24 ———</td>
<td>24 ———</td>
</tr>
<tr>
<td>25 ———</td>
<td>25 Page(s)</td>
<td>25 ———</td>
</tr>
<tr>
<td>26 Extent of Work</td>
<td>26 ———</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 Packaging Method</td>
<td>27 ———</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 ———</td>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 ———</td>
<td>32 ———</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 Connective Phrase</td>
<td>36 ———</td>
<td>36 ———</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ———</td>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
</tbody>
</table>
## Appendix B: ProCite Workforms and Fields

<table>
<thead>
<tr>
<th>Generic</th>
<th>Hearing</th>
<th>In Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Author, Analytic</td>
<td>1 Author(s)</td>
<td>1 Author(s)</td>
</tr>
<tr>
<td>2 ———</td>
<td>2 Author Role</td>
<td>2 ———</td>
</tr>
<tr>
<td>3 ———</td>
<td>3 Author Affiliation</td>
<td>3 ———</td>
</tr>
<tr>
<td>4 Title, Analytic</td>
<td>4 Title</td>
<td>4 Title</td>
</tr>
<tr>
<td>5 ———</td>
<td>5 Medium Designator</td>
<td>5 ———</td>
</tr>
<tr>
<td>6 ———</td>
<td>6 ———</td>
<td>6 ———</td>
</tr>
<tr>
<td>7 Author, Monographic</td>
<td>7 ———</td>
<td>7 ———</td>
</tr>
<tr>
<td>8 ———</td>
<td>8 ———</td>
<td>8 ———</td>
</tr>
<tr>
<td>9 Title, Monographic</td>
<td>9 ———</td>
<td>9 ———</td>
</tr>
<tr>
<td>10 Journal Title</td>
<td>10 ———</td>
<td>10 Journal Title</td>
</tr>
<tr>
<td>11 ———</td>
<td>11 ———</td>
<td>11 ———</td>
</tr>
<tr>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
<td>12 Reprint Status</td>
</tr>
<tr>
<td>13 ———</td>
<td>13 ———</td>
<td>13 ———</td>
</tr>
<tr>
<td>14 ———</td>
<td>14 ———</td>
<td>14 ———</td>
</tr>
<tr>
<td>15 ———</td>
<td>15 ———</td>
<td>15 ———</td>
</tr>
<tr>
<td>16 ———</td>
<td>16 ———</td>
<td>16 ———</td>
</tr>
<tr>
<td>17 ———</td>
<td>17 ———</td>
<td>17 ———</td>
</tr>
<tr>
<td>18 Place of Publication</td>
<td>18 Committee</td>
<td>18 ———</td>
</tr>
<tr>
<td>19 Publisher Name</td>
<td>19 Subcommittee</td>
<td>19 ———</td>
</tr>
<tr>
<td>20 Date of Publication</td>
<td>20 Hearing Date</td>
<td>20 Date of Publication</td>
</tr>
<tr>
<td>21 Date of Copyright</td>
<td>21 Date</td>
<td>21 ———</td>
</tr>
<tr>
<td>22 Volume ID</td>
<td>22 Bill Number</td>
<td>22 Volume ID</td>
</tr>
<tr>
<td>23 ———</td>
<td>23 ———</td>
<td>23 ———</td>
</tr>
<tr>
<td>24 Issue ID</td>
<td>24 Issue ID</td>
<td>24 ———</td>
</tr>
<tr>
<td>25 Location in Work</td>
<td>25 Location in Work</td>
<td>25 Page(s)</td>
</tr>
<tr>
<td>26 ———</td>
<td>26 ———</td>
<td>26 ———</td>
</tr>
<tr>
<td>27 ———</td>
<td>27 ———</td>
<td>27 ———</td>
</tr>
<tr>
<td>28 ———</td>
<td>28 ———</td>
<td>28 ———</td>
</tr>
<tr>
<td>29 ———</td>
<td>29 ———</td>
<td>29 ———</td>
</tr>
<tr>
<td>30 Series Editor</td>
<td>30 ———</td>
<td>30 ———</td>
</tr>
<tr>
<td>31 ———</td>
<td>31 ———</td>
<td>31 ———</td>
</tr>
<tr>
<td>32 Series Title</td>
<td>32 ———</td>
<td>32 ———</td>
</tr>
<tr>
<td>33 ———</td>
<td>33 ———</td>
<td>33 ———</td>
</tr>
<tr>
<td>34 ———</td>
<td>34 ———</td>
<td>34 ———</td>
</tr>
<tr>
<td>35 ———</td>
<td>35 ———</td>
<td>35 ———</td>
</tr>
<tr>
<td>36 ———</td>
<td>36 ———</td>
<td>36 ———</td>
</tr>
<tr>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
<td>37 Address/Availability</td>
</tr>
<tr>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
<td>38 Location/URL</td>
</tr>
<tr>
<td>39 ———</td>
<td>39 ———</td>
<td>39 ———</td>
</tr>
<tr>
<td>40 ISSN</td>
<td>40 ———</td>
<td>40 ———</td>
</tr>
<tr>
<td>41 ———</td>
<td>41 ———</td>
<td>41 ———</td>
</tr>
<tr>
<td>42 Notes</td>
<td>42 Notes</td>
<td>42 Notes</td>
</tr>
<tr>
<td>43 Abstract</td>
<td>43 Abstract</td>
<td>43 Abstract</td>
</tr>
<tr>
<td>44 Call Number</td>
<td>44 Call Number</td>
<td>44 Call Number</td>
</tr>
<tr>
<td>45 Keywords</td>
<td>45 Keywords</td>
<td>45 Keywords</td>
</tr>
</tbody>
</table>
### Journal Article

1. Author, Analytic
2. ———
3. ———
4. Article Title
5. Medium Designator
6. Connective Phrase
7. ———
8. ———
9. ———
10. Journal Title
11. Translated Title
12. Reprint Status
13. ———
14. ———
15. ———
16. ———
17. ———
18. ———
19. ———
20. Date of Publication
21. ———
22. Volume ID
23. ———
24. Issue ID
25. Page(s)
26. ———
27. ———
28. ———
29. ———
30. ———
31. ———
32. ———
33. ———
34. ———
35. Language
36. Connective Phrase
37. Address/Availability
38. Location/URL
39. ———
40. ISSN
41. ———
42. Notes
43. Abstract
44. Call Number
45. Keywords

### Journal Long Form

1. Author, Analytic
2. Author Role
3. Author Affiliation
4. Article Title
5. Medium Designator
6. Connective Phrase
7. Author, Monographic
8. Author Role
9. ———
10. Journal Title
11. ———
12. Reprint Status
13. ———
14. ———
15. ———
16. ———
17. ———
18. ———
19. ———
20. Date of Publication
21. ———
22. Volume ID
23. ———
24. Issue ID
25. Page(s)
26. ———
27. ———
28. ———
29. ———
30. ———
31. ———
32. ———
33. ———
34. ———
35. CODEN
36. ISSN
37. ———
38. Location/URL
39. ———
40. ISSN
41. ———
42. Notes
43. Abstract
44. Call Number
45. Keywords

### Journal Short Form

1. Author, Analytic
2. ———
3. ———
4. Article Title
5. Medium Designator
6. Connective Phrase
7. ———
8. ———
9. ———
10. Journal Title
11. ———
12. Reprint Status
13. ———
14. ———
15. ———
16. ———
17. ———
18. ———
19. ———
20. Date of Publication
21. ———
22. Volume ID
23. ———
24. Issue ID
25. Page(s)
26. ———
27. ———
28. ———
29. ———
30. ———
31. ———
32. ———
33. ———
34. ———
35. ———
36. ———
37. Address/Availability
38. Location/URL
39. ———
40. ISSN
41. ———
42. Notes
43. Abstract
44. Call Number
45. Keywords
<table>
<thead>
<tr>
<th>Journal Whole</th>
<th>Letter</th>
<th>Magazine Article</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>26</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>27</td>
<td>27</td>
</tr>
<tr>
<td>28</td>
<td>28</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>29</td>
<td>29</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>33</td>
<td>33</td>
<td>33</td>
</tr>
<tr>
<td>34</td>
<td>34</td>
<td>34</td>
</tr>
<tr>
<td>35</td>
<td>35</td>
<td>35</td>
</tr>
<tr>
<td>36</td>
<td>36</td>
<td>36</td>
</tr>
<tr>
<td>37</td>
<td>37</td>
<td>37</td>
</tr>
<tr>
<td>38</td>
<td>38</td>
<td>38</td>
</tr>
<tr>
<td>39</td>
<td>39</td>
<td>39</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>41</td>
<td>41</td>
<td>41</td>
</tr>
<tr>
<td>42</td>
<td>42</td>
<td>42</td>
</tr>
<tr>
<td>43</td>
<td>43</td>
<td>43</td>
</tr>
<tr>
<td>44</td>
<td>44</td>
<td>44</td>
</tr>
<tr>
<td>45</td>
<td>45</td>
<td>45</td>
</tr>
<tr>
<td>Manuscript</td>
<td>Map</td>
<td>Monograph</td>
</tr>
<tr>
<td>------------</td>
<td>-----</td>
<td>-----------</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>11</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td>13</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>14</td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td>17</td>
<td>17</td>
<td>17</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td>19</td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>21</td>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td>24</td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td>25</td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>26</td>
<td>26</td>
</tr>
<tr>
<td>27</td>
<td>27</td>
<td>27</td>
</tr>
<tr>
<td>28</td>
<td>28</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>29</td>
<td>29</td>
</tr>
<tr>
<td>30</td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td>31</td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>33</td>
<td>33</td>
<td>33</td>
</tr>
<tr>
<td>34</td>
<td>34</td>
<td>34</td>
</tr>
<tr>
<td>35</td>
<td>35</td>
<td>35</td>
</tr>
<tr>
<td>36</td>
<td>36</td>
<td>36</td>
</tr>
<tr>
<td>37</td>
<td>37</td>
<td>37</td>
</tr>
<tr>
<td>38</td>
<td>38</td>
<td>38</td>
</tr>
<tr>
<td>39</td>
<td>39</td>
<td>39</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td>41</td>
<td>41</td>
<td>41</td>
</tr>
<tr>
<td>42</td>
<td>42</td>
<td>42</td>
</tr>
<tr>
<td>43</td>
<td>43</td>
<td>43</td>
</tr>
<tr>
<td>44</td>
<td>44</td>
<td>44</td>
</tr>
<tr>
<td>45</td>
<td>45</td>
<td>45</td>
</tr>
</tbody>
</table>
### Motion Picture
- Title, Analytic
- Medium Designator
- Producer
- Producer Role
- Reprint Status
- Director
- Director Role
- Place of Publication
- Distributor
- Date of Publication
- Timing
- Packaging Method
- Size
- Connective Phrase
- Address/Availability
- Location/URL
- ISBN
- Notes
- Abstract
- Call Number
- Keywords

### Music Score
- Composer
- Composer Role
- Title, Analytic
- Medium Designator
- Connective Phrase
- Editor/Compiler
- Editor/Compiler Role
- Title, Monographic
- Reprint Status
- Author, Subsidiary
- Author Role
- Place of Publication
- Publisher Name
- Date of Publication
- Copyright Date
- Volume ID
- Report ID
- Place in Work
- Extent of Work
- Packaging Method
- Connective Phrase
- Address/Availability
- Location/URL
- ISBN
- Notes
- Abstract
- Call Number
- Keywords

### Newspaper
- Author, Analytic
- Author Role
- Article Title
- Medium Designator
- Connective Phrase
- Reprint Status
- Newspaper Name
- Place of Publication
- Date of Publication
- Section
- Column Number
- Page(s)
- Address/Availability
- Location/URL
- ISBN
- Notes
- Abstract
- Call Number
- Keywords
## Patent

1. Inventor
2. ———
3. Address
4. Patent Title
5. ———
6. ———
7. Assignee
8. ———
9. Title, Short Form
10. ———
11. Title, Long Form
12. Abstract Journal Date
13. Country
14. Document Type
15. Patent Number
16. ———
17. ———
18. Abstract Journal Title
19. ———
20. Date of Patent Issue
21. Application No./Date
22. Abstract Journal Volume
23. ———
25. Abstract Journal Page(s)
26. Extent of Work
27. Packaging Method
28. ———
29. ———
30. ———
31. ———
32. ———
33. ———
34. ———
35. Language
36. Connective Phrase
37. Address/Availability
38. Location/URL
39. Class Code, National
40. Class Code, International
41. Related Document
42. Notes
43. Abstract
44. Registry Number
45. Keywords

## Report

1. Author, Analytic
2. Author Role
3. Author Affiliation
4. Section Title
5. Medium Designator
6. Connective Phrase
7. Author, Monographic
8. Author Role
9. Report Title
10. ———
11. ———
12. Reprint Status
13. ———
14. ———
15. Edition
16. Author, Subsidiary
17. Author Role
18. Place of Publication
19. Publisher Name
20. Date of Publication
21. ———
22. ———
23. Report ID
24. ———
25. ———
26. Extent of Work
27. Packaging Method
28. ———
29. ———
30. ———
31. ———
32. ———
33. ———
34. ———
35. ———
36. ———
37. ———
38. ———
39. ———
40. ———
41. ISBN
42. Notes
43. Abstract
44. Call Number
45. Keywords

## Sound Recording

1. Composer
2. Composer Role
3. ———
4. Title, Analytic
5. Medium Designator
6. Connective Phrase
7. Editor/Compiler
8. Editor/Compiler Role
9. Recording Title
10. ———
11. ———
12. Reprint Status
13. ———
14. ———
15. Edition
16. Performer
17. Performer Role
18. Place of Publication
19. Publisher Name
20. Date of Publication
21. Date of Copyright
22. Acquisition Number
23. Matrix Number
24. ———
25. ———
26. Extent of Work
27. Packaging Method
28. Size
29. Reproduction Ratio
30. ———
31. ———
32. Series Title
33. Series Volume ID
34. Series Issue ID
35. ———
36. ———
37. ———
38. ———
39. ———
40. ———
41. ISBN
42. Notes
43. Abstract
44. Call Number
45. Keywords
<table>
<thead>
<tr>
<th>Statute</th>
<th>Trade Catalog</th>
<th>Unenacted Bill-Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Author(s)</td>
<td>Catalog Author</td>
<td>Author(s)</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Statute Title</td>
<td>Catalog Title</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>Medium Designator</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>Reprint Status</td>
<td>Reprint Status</td>
<td>Reprint Status</td>
</tr>
<tr>
<td>12</td>
<td>12</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>14</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>17</td>
<td>17</td>
</tr>
<tr>
<td>Code</td>
<td>18</td>
<td>Code</td>
</tr>
<tr>
<td>19</td>
<td>19</td>
<td></td>
</tr>
<tr>
<td>Date of Publication</td>
<td>Date of Code</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>Date</td>
<td>21</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>Title/Code Number</td>
<td>Catalog Number</td>
<td>Bill/Res Number</td>
</tr>
<tr>
<td>23</td>
<td>23</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>24</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>25</td>
</tr>
<tr>
<td>Section(s)</td>
<td>Extent of Work</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>26</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>27</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>28</td>
<td>28</td>
</tr>
<tr>
<td></td>
<td>29</td>
<td>29</td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>31</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>History</td>
<td>33</td>
<td>33</td>
</tr>
<tr>
<td>34</td>
<td>34</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>35</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>36</td>
<td>36</td>
</tr>
<tr>
<td>Connective Phrase</td>
<td>Address/Availability</td>
<td>Address/Availability</td>
</tr>
<tr>
<td>37</td>
<td>37</td>
<td>37</td>
</tr>
<tr>
<td></td>
<td>38</td>
<td>38</td>
</tr>
<tr>
<td>Location/URL</td>
<td>Location/URL</td>
<td>Location/URL</td>
</tr>
<tr>
<td>39</td>
<td>39</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>41</td>
<td>41</td>
</tr>
<tr>
<td>Notes</td>
<td>42</td>
<td>42</td>
</tr>
<tr>
<td>Abstract</td>
<td>43</td>
<td>43</td>
</tr>
<tr>
<td>Call Number</td>
<td>44</td>
<td>44</td>
</tr>
<tr>
<td>45</td>
<td>45</td>
<td>45</td>
</tr>
<tr>
<td>Keywords</td>
<td></td>
<td>Keywords</td>
</tr>
</tbody>
</table>
### Unpublished Work

<p>| | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Author(s)</td>
<td>1</td>
<td>Author, Analytic</td>
<td>1</td>
<td>Author(s)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>———</td>
<td>2</td>
<td>———</td>
<td>2</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>———</td>
<td>3</td>
<td>———</td>
<td>3</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Title</td>
<td>4</td>
<td>Title, Analytic</td>
<td>4</td>
<td>Reprint Status</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>———</td>
<td>5</td>
<td>———</td>
<td>5</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>———</td>
<td>6</td>
<td>———</td>
<td>6</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Editor(s)</td>
<td>7</td>
<td>Producer</td>
<td>7</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>———</td>
<td>8</td>
<td>Producer Role</td>
<td>8</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>———</td>
<td>9</td>
<td>———</td>
<td>9</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>———</td>
<td>10</td>
<td>———</td>
<td>10</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>———</td>
<td>11</td>
<td>———</td>
<td>11</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Reprint Status</td>
<td>12</td>
<td>Reprint Status</td>
<td>12</td>
<td>Reprint Status</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>———</td>
<td>13</td>
<td>———</td>
<td>13</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>———</td>
<td>14</td>
<td>———</td>
<td>14</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>———</td>
<td>15</td>
<td>———</td>
<td>15</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>———</td>
<td>16</td>
<td>Director</td>
<td>16</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>———</td>
<td>17</td>
<td>Director Role</td>
<td>17</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>———</td>
<td>18</td>
<td>Place of Publication</td>
<td>18</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>———</td>
<td>19</td>
<td>Distributor</td>
<td>19</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Date of Publication</td>
<td>20</td>
<td>Date of Publication</td>
<td>20</td>
<td>Date of Publication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Date of Copyright</td>
<td>21</td>
<td>———</td>
<td>21</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>———</td>
<td>22</td>
<td>———</td>
<td>22</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>———</td>
<td>23</td>
<td>———</td>
<td>23</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>———</td>
<td>24</td>
<td>———</td>
<td>24</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>———</td>
<td>25</td>
<td>———</td>
<td>25</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>———</td>
<td>26</td>
<td>Extent of Work</td>
<td>26</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>———</td>
<td>27</td>
<td>Packaging Method</td>
<td>27</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>———</td>
<td>28</td>
<td>Size</td>
<td>28</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>———</td>
<td>29</td>
<td>———</td>
<td>29</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>———</td>
<td>30</td>
<td>———</td>
<td>30</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>———</td>
<td>31</td>
<td>———</td>
<td>31</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>———</td>
<td>32</td>
<td>Series Title</td>
<td>32</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>———</td>
<td>33</td>
<td>———</td>
<td>33</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>———</td>
<td>34</td>
<td>———</td>
<td>34</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>———</td>
<td>35</td>
<td>———</td>
<td>35</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>———</td>
<td>36</td>
<td>Connective Phrase</td>
<td>36</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Address/Availability</td>
<td>37</td>
<td>Address/Availability</td>
<td>37</td>
<td>Address/Availability</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Location/URL</td>
<td>38</td>
<td>Location/URL</td>
<td>38</td>
<td>Location/URL</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>———</td>
<td>39</td>
<td>———</td>
<td>39</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>———</td>
<td>40</td>
<td>———</td>
<td>40</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>———</td>
<td>41</td>
<td>ISBN</td>
<td>41</td>
<td>———</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>Notes</td>
<td>42</td>
<td>Notes</td>
<td>42</td>
<td>Notes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Abstract</td>
<td>43</td>
<td>Abstract</td>
<td>43</td>
<td>Abstract</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Call Number</td>
<td>44</td>
<td>Call Number</td>
<td>44</td>
<td>Call Number</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Keywords</td>
<td>45</td>
<td>Keywords</td>
<td>45</td>
<td>Keywords</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## The 45 ProCite Fields

1. Author, Analytic/Author(s)/Artist/Catalog Author/Composer/Counsel/Inventor
2. Author Role/Artist Role/Composer Role/Author E-mail
3. Author Affiliation/Address
4. Title, Analytic/Act Title/Article Title/Case Name/Catalog Title/Map Title/Patent Title/Program Title/Subject/Statute Title
5. Medium Designator/Computer Program/Data File/Medium/Map Type
6. Connective Phrase
7. Author, Monographic/Assignee/Editor/Programmer/Cartographer/Compiler/Producer/Recipient
8. Author Role/Cartographer Role/Editor Role/Producer Role
9. Title, Monographic/Case Name (Abbrev)/Collection Title/Recording Title/Report Title/Short Form Title
10. Journal Title/Magazine Title
11. Title/Newspaper Name/Translated Title/Subsidiary Title
12. Reprint Status/Date of Meeting/Abstract Journal Date
13. Country/Place of Meeting
14. Document Type/Medium Designator
15. Edition/Version
16. Author, Subsidiary/Director/Performer
17. Author Role/Director Role/Performer Role
18. Place of Publication/Abstract Journal/Code/Committee/Reporter
19. Publisher Name/Distributor/University/Subcommittee/Court
20. Date of Publication/Date of Letter/Patent Issue Date/Date of Code/Last Update/Hearing Date/Date Filed
21. Date of Copyright/Original Publication Date/Access Date/Date Decided
22. Volume ID/Acquisition Number/Catalog Number/Section/Abstract Journal Volume/Bill-Res Number
23. Report ID/Matrix Number
24. Issue ID/Abstract Journal Issue/Plate Number/Reporter Number
25. Location in Work/Page(s)/Abstract Journal Pages/Section
27. Packaging Method
28. Size
29. Reproduction Ratio/Frequency of Publication/Scale
30. Series Editor
31. Series Editor Role
32. Series Title/History
33. Series Volume ID
34. Series Issue ID
35. Document Type/Language
36. Connective Phrase
37. Address/Availability
38. Location/URL
39. CODEN/Class Code, National
40. ISSN/Class Code, International
42. Notes
43. Abstract
44. Call Number/Registry Number
45. Keywords
Appendix C

Sample Download Files

Overview

This appendix shows examples of download files from various information systems, along with downloading tips as appropriate. ProCite ships with configuration files that transfer these records. For a list of shipping configuration files, and the databases with which they work, see Appendix D: Configuration Files.

The configuration files shipped with ProCite are set up to work only with bibliographic databases. Fields are mapped to transfer text to the most likely matching field in ProCite. You may have different ideas about where information should transfer, in which case you can modify the configuration files. The configuration files were accurate at creation, but information providers constantly update their systems. Again, you may need to make modifications to accurately transfer text to the appropriate ProCite workforms and fields.

If you plan to create a configuration file for a system not listed here, first look at the sample records and find the records that are closest in format to the records you want to transfer. It is often easier to modify a copy of an existing configuration file rather than start with an empty configuration file.

When downloading records, you should always record your entire search session and save it to a text-only disk file. ProCite needs to identify the source database as well as each record and each field within each record. It's easy to delete unwanted records from ProCite after importing.

Included here are sample records from:

- Current Contents on CD - OVID
- Current Contents on CD - Reprint
- Dialog
- Medlars
- Melvyl
- OVID Online
- OVID OVID
- ProQuest
- SilverPlatter
- STN
Current Contents on CD - OVID

Use this configuration file: CC on CD - OVID
Sample Current Contents  OVID record from the Life Science database:

<20>
Accession Number
  MC193-0013
Document Delivery
  The Genuine Article Number: MC193
Authors
  Houston BJ.  Macallum GE.  Walker RM.  Albassam MA.
  Gough A.  Smith GS.
Title
  TOXICITY OF CI-949, A NOVEL ANTI-ALLERGY AGENT
Source
  Fundamental & Applied Toxicology.  21(3):376-383,
  1993 Oct.
ISSN
  0272-0590
KeyWords Plus
  Mediator release inhibitor.  Therapeutic efficacy.
Beagles.
Language
  English
Publication Type
  Article
CC Categories
  Pharmacology.
Subset
  Current Contents/Life Sciences
Institution
  Reprint available from:
  Houston BJ
  PARKE DAVIS RES INST
  2270 SPEAKMAN DR
  MISSISSAUGA L5K 1B4
  ONTARIO
  CANADA
  WARNER LAMBERT PARKE DAVIS
  PARKE DAVIS PHARMACEUT RES
  ANN ARBOR, MI 48104
  USA
Current Contents on CD-Reprint

Use this configuration file: CC on CD Reprint
Sample Current Contents Reprint record from the Clinical Science database:

3
UI  - ML242-0009
AU  - Vanhagehamsten M
AU  - Harfast B
AU  - Johansson SGO
TI  - DUST MITE ALLERGY - AN IMPORTANT CAUSE OF RESPIRATORY DISEASE IN FARMERS
IS  - 0271-3586
MH  - Lepidoglyphus destructor
MH  - Storage mites
MH  - Occupational asthma
MH  - Organic dusts
MH  - Storage mites. Lepidoglyphus-destructor. Farming population
AB  - In 2,578 Swedish farmers, 6.2% were found to have an allergy to storage mites. The storage mite Lepidoglyphus destructor has been identified by both RAST and bronchial challenges as a significant cause of occupational asthma in rural environments. Immunohistochemical studies of L. destructor disclosed that at least one L. destructor allergen is associated with digestion.
(C) 1994 Wiley-Liss, Inc. [References: 12]
LG  - English
PT  - Note
SB  - Current Contents/Clinical Medicine
IN  - Reprint available from:
    Vanhagehamsten M
    KAROLINSKA HOSP
    DEPT CLIN IMMUNOL
    BOX 60500
    S-10401 STOCKHOLM
    SWEDEN
Use this configuration file: DIALOG.CFG

When downloading, record your entire Dialog search session. The supplied configuration file works best with records retrieved in tagged Format 4. You can retrieve records in other tagged formats, but you will need to modify the configuration file for accurate record transfer. You can also transfer OneSearch records retrieved in a tagged format.

Sample Dialog record from database 1 (ERIC):

1/2/10
SO- <AN>  EJ363746
SO- <AN>  HE523377
AU- Green, William Scott
SO- <JN>  Liberal Education^v73 n5 p21-25 Nov-Dec
SO- <PY> 1987
AV- UMI
LA- ENGLISH
DT-  JOURNAL ARTICLE (080); POSITION PAPER (120)
JA- CIJAPR99
DE- *College Curriculum^*Educational Attitudes^Higher Education^Humanities Instruction^*Liberal Arts^*Religion^ *Religious Education^*Social Values||
Medlars

Use this configuration file: MEDLARS.CFG

Record your entire MEDLARS search session so ProCite can identify database names. The supplied configuration file can transfer tagged records retrieved with a standard communication package or the National Library of Medicine's Grateful Med software, plus records from Beth Israel Hospital's PaperChase system.

You will get more accurate results if you use the **Print Detailed** command when you retrieve MEDLARS records; it expands the SO (Source) field for journals into separately tagged fields.

Sample MEDLARS record from MEDLINE in "Print Detailed" format:

```plaintext
1
UI -85276784
AU -Leeder JS
AU -Robertson C
TI -Evaluation of serum theophylline concentrations following administration of sustained-release beads in applesauce to asthmatic preschool children.
LA -Eng
MH -Asthma/BLOOD/DRUG THERAPY
MH -Theophylline/ADMINISTRATION & DOSAGE/*BLOOD/METABOLISM
DA -860318
DP -1986 Feb
IS -0003-4738
TA -Ann Allergy
PG -133-7
SB -M
ZN -Z1.107.567.875
IP -2
VI -56
JC -4XC
AA -Author
RM -58-55-9 (Theophylline)
EM -8605
AB -A sustained-release theophylline preparation (Theo-Dur Sprinkle) was evaluated in young asthmatic patients aged 1 to 6 years and receiving a daily dose.
```
Use this configuration file: MELVYL.CFG
Sample Melvyl record from the Computer Articles database:

1.
AN  14625271
DT  ARTICLE - Product Announcement
PA  Lawton, Stephen
AT  Internet access could get cable TV boost. (Zenith Electronics Corp. and Spry Inc. demonstrate system to connect to Internet over cable TV lines)
     (Product Announcement)
JT  Digital News & Review
VO  10
NR  20
IS  Oct 25
DP  1993
PG  9(1)
ZZ
Use this configuration file: OVID Online.CFG
Sample OVID Online record from the Biosis database:

8 of 30
AN 095002594
AU Eichholz M W. Koenig W D.
IN HASTINGS RESERVATION, UNIV. CALIF., 38601 EAST CARMEL VALLEY ROAD, CARMEL VALLEY, CALIF. 93224, USA.
TI GOPHER SNAKE ATTRACTION TO BIRDS’ NESTS.
KW PITUOPHIS-CATENIFER PITUOPHIS-MELANOLEUCUS LAMPROPELTIS-GETULUS SIALIA-MEXICANA PREDATION.
CC *Behavioral Biology/Animal Behavior [07003] *Ecology; Environmental Biology/Animal [07508]
BC Biosystematic Codes/Super Taxonomic Groups:
Serpentes [85410]
Passeriformes [85548]
AB Snakes, primarily gopher snakes (Pituophis catenifer, formerly P. melanleucus) but also common kingsnakes (Lampropeltis getulus), commonly depradate nests of western bluebirds (Sialia mexicana) and other avian species at Hastings Reservation in central coastal California. Snakes preferentially climb trees containing active nests of western bluebirds situated in artificial nestboxes. Snakes rarely attack nests containing eggs, and attractiveness appears to increase with nestling age.
LG English.
PT Article.
IS 0038-4909
UP 9300
YR 1992
Use this configuration file: OVID OVID.CFG
Sample OVID OVID record from the Cinahl database:

<4>
Accession Number
  1993173623   NLM Unique Identifier: 93372535.
Authors
  Davis JE.
Title
  Ethical and legal issues in suicide.
Source
  British Journal of Nursing.  2(15):777-80, 1993 Aug 12-Sep 8.  (23 ref)
Document Delivery
  NLM Serial Identifier: SR0074170.
Journal Subset
  Nursing Journals.  Peer Reviewed Journals.  UK & Ireland Journals.
Cinahl Subject Headings
  Autonomy, *Decision Making, Ethical, *Ethics, Nursing, Suicide/lj [Legislation and Jurisprudence], *Suicide, *Suicide, Attempted, United Kingdom
Abstract
  Nurse-patient encounters are influenced by the law and by morality. These frequently overlap and hold certain principles in common, such as justice and rights. Despite such close connections, the law and morality do not necessarily correspond. The difficulty in and complexity of reaching the right and just decision in the healthcare setting often highlight this.
  (23 ref)
ISSN
  0966-0461
Publication Type
  Journal.  Tables/Charts.
Language
  English.
Entry Month
  9312
Use this configuration file: OVID Reprint.CFG
Sample OVID Reprint record from the Embase 95 database:

10
UI  - 95033424
AU - Meijer JG
AU - Van Wieringen N
AU - Koedooder C
AU - Nieuwenhuys GJ
AU - Van Dijk JDP
IN - Kamerlingh Onnes Laboratory, Leiden State
     University, Leiden; Netherlands.
CP - United States of America
TI - The development of PdNi thermoseeds for
     interstitial hyperthermia.
MH - Cancer Therapy
MH - Magnetism
MH - Priority Journal
MH - Article
MH - *Ferromagnetic Material
MH - *Palladium
MH - *Nickel
AB - Magnetic induction heating of thermoseed
     implants can be used to produce highly localized
     hyperthermia in deep-seated tumors. Automatic
     temperature control throughout the tumor can be
     achieved by the self-regulating character of
     ferromagnetic seeds, which corrects for local
     variations in heat loss due to blood perfusion.
     An increased sharpness of the ferromagnetic
     transition at the Curie temperature, T(c),
     improves the performance of self-regulating
     control. This was realized for palladium-nickel
     alloys by a ‘cold working’ procedure preceded
     and followed by annealing. Palladium nickel
     seeds with a predetermined T(c) were produced,
     showing a sharp decrease at T(c) of the magnetic
     susceptibility and the heat production.
RN - 7440-02-0
IS - 0094-2405
LG - English
PT - Journal
EM - 9503
Use one of these configuration files: ProQuest.CFG  
ProQuest 2.CFG

ProQuest databases vary in how fields are saved to disk. A single configuration file cannot accurately transfer text from all databases. See your ProCite User's Guide, Appendix C: Configuration Files to determine which configuration file works with each ProQuest database.

Sample ProQuest record from the ABI/Inform Global Edition database (transfers with ProQuest.CFG):

Access No:   00861941  ProQuest  ABI/INFORM (R)  
Global Edition
Title:       New definitions, perceptions needed in healthcare debate
Authors:     Toomey, Robert E
Journal:     Modern Healthcare (MHC)  ISSN: 0160-7480  
Vol: 24  Iss: 23  Date: Jun 6, 1994  
p: 30
Subjects:    Health care policy; Reforms; Health care networks; Health care delivery;  
Definitions; Perceptions
Geo Places:  US
Codes:       1200 (Social policy); 8320 (Health care industry); 9190 (United States)

Abstract:    Everyone seems to believe that community-care networks and regional, comprehensive systems are needed to make healthcare affordable. If that is true, the major stumbling blocks to building such systems need to be identified and steps taken to make them operationally effective.

The notion of community and the meaning of healthcare must be redefined. More attention must be paid to health status, as well as disease status, and social models of care must be built that incorporate community-based efforts to improve health status as well as to cure diseases.
Use this configuration file: SilverPlatter (SPIRS).CFG

Sample SilverPlatter record from the Medline database:

Record 10 of 26 - MEDLINE (R) 1994

TI: Protective effect of albuterol delivered via a spacer device (Babyhaler) against methacholine induced bronchoconstriction in young wheezy children.

AU: Avital-A; Godfrey-S; Schachter-J; Springer-C

SO: Pediatr-Pulmonol. 1994 May; 17(5): 281-4

LA: ENGLISH

AB: Nine young asthmatic children aged 2-5 years underwent methacholine challenge after placebo or albuterol administered by metered dose inhaler through a spacer device (Babyhaler) with a face mask in a double-blind, cross-over, randomized study. The methacholine challenge was performed using chest auscultation to define the provocative concentration of methacholine that causes wheezing (PCW). The PCW increased from a geometric mean of 0.28 mg/mL after placebo to 3.59 mg/mL after albuterol (P < 0.0001). The protective effect of albuterol against methacholine-induced bronchospasm was 3.7 +/- 1.2 doubling doses. We conclude that administration of drugs from a metered dose inhaler through the Babyhaler with a face mask is effective. Albuterol causes a major reduction in the bronchial hyperreactivity in young wheezy children shortly after administration.

MESH: Asthma-physiopathology; Child,-Preschool; Double-Blind-Method; Respiratory-Sounds

MESH: *Albuterol-administration-and-dosage; *Asthma-drug-therapy; *Bronchial-Provocation-Tests; *Bronchoconstriction-drug-effects; *Methacholine-Chloride-diagnostic-use; *Nebulizers-and-Vaporizers

AN: 94336321
Use one of these configuration files:  
STN (4 tag area).CFG  
STN (5 tag area).CFG  
STN (6 tag area).CFG  

STN databases vary in how fields are saved to disk. Depending on the database, the tag area (from the left margin to field text) is either four, five, or six characters. A single configuration file cannot accurately transfer text from all three formats. See your ProCite User’s Guide, Appendix C: Configuration Files to determine which configuration file works with each STN database. Or, examine your download file to determine the tag area width.

Sample STN record from the Inspec database, which transfers with the STN (4 tag area).CFG file:

L8   ANSWER 10 OF 10 COPYRIGHT 1993 IEE  
AN  71:281893 INSPEC DN A71051986  
TI Acetate glasses.  
AU Van Uitert, L.G.; Bonner, W.A.; Grodkiewicz, W.H. (Bell Telephone Labs. Inc., Murray Hill, NJ, USA)  
SO Materials Research Bulletin (June 1971) vol.6, no.6, p.513-18 CODEN: MRBUAC ISSN: 0025-5408  
DT Journal  
TC Experimental  
CY United States  
LA English  
AB A number of new glasses have been prepared. These include Y and/or rare earth CH3- and ***CF3***-acetates with and without alkali metal acetate additions. Like the nitrate glasses these materials melt in the 100 to 350 degrees C range and tend to be most stable for anion to cation ratios of approximately 1.4. The trivalent ions of Sm, Eu, Tb and Dy fluoresce under long wave u.v. and spark coil excitation in these materials.  
CC A6140D Glasses  
CT GLASS; ***LUMINESCENCE*** OF ORGANIC SOLIDS; ORGANIC COMPOUNDS  
ST acetate glasses; rare earth; Y; alkali metal acetate; trivalent ions; spark coil excitation; long wave ultraviolet  
ET Y; C*H; CH3; C cp; cp; H cp; C*F; CF3; F cp; C; Sm; Eu; Tb; Dy
Appendix D
Configuration Files

Overview

This appendix lists configuration files supplied in order to import tagged records from various information services into a ProCite database. The following is a list of database services that are supported by ProCite, in alphabetical order by provider.

- CC on CD OVID.cfg (Current Contents)
- CC on CD Reprint.cfg (Current Contents)
- Dialog.cfg
- MEDLARS.cfg (National Library of Medicine)
- Melvyl.cfg
- OVID Online.cfg (formerly CD-Plus OVID Online)
- OVID OVID.cfg (formerly CD-Plus OVID)
- OVID Reprint.cfg (formerly CD-Plus OVID Reprint)
- PROQUEST.cfg
- PROQUEST 2.cfg
- SilverPlatter (SPIRS).cfg
- STN 4 (4 tag area).cfg
- STN 5 (5 tag area).cfg
- STN 6 (6 tag area).cfg

For each configuration file, this appendix lists the databases supported. Some systems do not offer multiple databases. ProQuest and STN require different configuration files depending upon the database from which the records were retrieved.

These configuration files were accurate at time of creation. However, each system periodically updates its offerings, and may alter the layout of retrieved records. You can modify any of the configuration files, or create entirely new configuration files, with the Biblio-Link II program found in your ProCite folder.
<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ERIC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>2</td>
<td>INSPEC (1969-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>4</td>
<td>INSPEC (1983-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>5</td>
<td>BIOSIS PREVIEWS (1969-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>6</td>
<td>NTIS</td>
<td>Report</td>
</tr>
<tr>
<td>7</td>
<td>SOCIAL SCISEARCH</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>8</td>
<td>COMPENDEX PLUS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>10</td>
<td>AGRICOLA (1979-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>11</td>
<td>PSYCINFO</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>15</td>
<td>ABI/INFORM</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>16</td>
<td>PTS PROMT</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>18</td>
<td>PTS F&amp;S INDEX</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>32</td>
<td>METADEX</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>34</td>
<td>SCISEARCH (1988-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>35</td>
<td>Dissertation ABSTRACTS ONLINE</td>
<td>Dissertation</td>
</tr>
<tr>
<td>36</td>
<td>LINGUISTICS AND LANGUAGE BEHAVIOR A</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>37</td>
<td>SOCIOLOGICAL ABSTRACTS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>38</td>
<td>AMERICA: HISTORY AND LIFE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>39</td>
<td>HISTORICAL ABSTRACTS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>42</td>
<td>PHARMACEUTICAL NEWS INDEX (PNI)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>46</td>
<td>A-V ONLINE</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>47</td>
<td>MAGAZINE INDEX</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>50</td>
<td>CAB ABSTRACTS (1984-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>51</td>
<td>FOOD SCIENCE AND TECHNOLOGY ABSTRACTS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>53</td>
<td>CAB ABSTRACTS (1972-1983)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>55</td>
<td>BIOSIS PREVIEWS (1985-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>56</td>
<td>ARTBIBLIOGRAPHIES MODERN</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>58</td>
<td>GEOARCHIVE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>61</td>
<td>LISA</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>62</td>
<td>SPIN</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>Database</td>
<td>Description</td>
<td>ProCite Workform</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>64....CHILD ABUSE AND NEGLECT AND FAMILY ......</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>68....ENVIRONMENTAL BIBLIOGRAPHY ..............</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>69....ENERGYLINE ..................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>72....EMBASE (1985-) ................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>73....EMBASE (1974-) ................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>74....INTERNATIONAL PHARMACEUTICAL ABSTRA ......</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>75....MANAGEMENT CONTENTS ........................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>76....LIFE SCIENCES COLLECTION ..................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>77....CONFERENCE PAPERS INDEX ....................</td>
<td>Conference Proceedings</td>
<td></td>
</tr>
<tr>
<td>86....MENTAL HEALTH ABSTRACTS ...................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>88....ACADEMIC INDEX ................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>89....GEOREF ........................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>97....MUSIC LITERATURE INTERNATIONAL (RIL) .....</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>103....ENERGY SCIENCE &amp; TECHNOLOGY .............</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>108....AEROSPACE DATABASE ........................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>109....NUCLEAR SCIENCE ABSTRACTS ...............</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>110....AGRICOLA (1970-1978) ......................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>111....NATIONAL Newspaper INDEX ..................</td>
<td>Newspaper</td>
<td></td>
</tr>
<tr>
<td>125....CLAIMS/U.S. PATENTS(Current) .............</td>
<td>Patent</td>
<td></td>
</tr>
<tr>
<td>136....FEDERAL REGISTER ABSTRACTS ..............</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>144....PASCAL .......................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>146....WASHINGTON POST ................................</td>
<td>Newspaper</td>
<td></td>
</tr>
<tr>
<td>148....TRADE AND INDUSTRY INDEX ..................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>149....HEALTH PERIODICALS DATABASE ..............</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>150....LEGAL RESOURCE INDEX ........................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>151....HEALTH PLANNING AND ADMINISTRATION ........</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>152....MEDLINE (1966-1974) ........................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>153....MEDLINE (1975-1984) ........................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>154....MEDLINE (1985-) ............................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>155....MEDLINE (1966-) .............................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>156....TOXLINE ......................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>157....AIDSLINE ......................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>158....DIOGENES ......................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>159....CANCERLIT .....................................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>185....ZOOLOGICAL RECORD ONLINE ...................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>192....INDUSTRY TRENDS AND ANALYSIS .............</td>
<td>Report</td>
<td></td>
</tr>
<tr>
<td>202....INFORMATION SCIENCE ABSTRACTS ..........</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>203....AGRIS INTERNATIONAL ........................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>211....NEWSSEARCH (Daily updates for Files) ...</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>218....NURSING AND ALLIED HEALTH (CINAHL) ........</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>223....CLAIMS/U.S. PATENTS (UNITERM, 1950- ....</td>
<td>Patent</td>
<td></td>
</tr>
<tr>
<td>224....CLAIMS/U.S. PATENTS (UNITERM, 1971- ....</td>
<td>Patent</td>
<td></td>
</tr>
<tr>
<td>225....CLAIMS/U.S. PATENTS (UNITERM, 1982- ....</td>
<td>Patent</td>
<td></td>
</tr>
<tr>
<td>233....MICROCOMPUTER INDEX ........................</td>
<td>Journal Long Form</td>
<td></td>
</tr>
<tr>
<td>Database</td>
<td>Description</td>
<td>ProCite Workform</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>239</td>
<td>MATHSCI</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>257</td>
<td>API ENERGY BUSINESS NEWS INDEX (API)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>258</td>
<td>AP NEWS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>260</td>
<td>UPI NEWS (1983-, except last 3 mont</td>
<td>Newspaper</td>
</tr>
<tr>
<td>261</td>
<td>UPI NEWS (Current 3 months)</td>
<td>Newspaper</td>
</tr>
<tr>
<td>262</td>
<td>CANADIAN BUSINESS AND CURRENT AFFAI</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>275</td>
<td>COMPUTER DATABASE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>293</td>
<td>ENGINEERED MATERIALS ABSTRACTS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>299</td>
<td>MAGILL'S SURVEY OF CINEMA</td>
<td>Motion Picture</td>
</tr>
<tr>
<td>308</td>
<td>CA SEARCH (1967-1971)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>309</td>
<td>CA SEARCH (1972-1976)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>311</td>
<td>CA SEARCH (1982-1986)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>313</td>
<td>CA SEARCH (1992- )</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>323</td>
<td>RAPRA ABSTRACTS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>340</td>
<td>CLAIMS/U.S. PATENTS (1950-)</td>
<td>Patent</td>
</tr>
<tr>
<td>341</td>
<td>CLAIMS/U.S. PATENTS (UNITERM, 1950-</td>
<td>Patent</td>
</tr>
<tr>
<td>345</td>
<td>INPADOC/FAMILY AND LEGAL STATUS</td>
<td>Patent</td>
</tr>
<tr>
<td>351</td>
<td>WORLD PATENTS INDEX (1981-)</td>
<td>Patent</td>
</tr>
<tr>
<td>399</td>
<td>CA SEARCH (1967-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>421</td>
<td>REMARC (-1900)</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>422</td>
<td>REMARC (1900-1939)</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>423</td>
<td>REMARC (1940-1959)</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>424</td>
<td>REMARC (1960-1969)</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>426</td>
<td>LC MARC - BOOKS</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>430</td>
<td>BRITISH BOOKS IN PRINT</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>434</td>
<td>SCISEARCH (1974- )</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>439</td>
<td>ARTS AND HUMANITIES SEARCH</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>440</td>
<td>CURRENT CONTENTS SEARCH</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>442</td>
<td>AMERICAN MEDICAL ASSOCIATION JOURNAL</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>444</td>
<td>NEW ENGLAND JOURNAL OF MEDICINE ONL</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>470</td>
<td>BOOKS IN PRINT</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>484</td>
<td>NEWSPAPER AND PERIODICAL ABSTRACTS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>498</td>
<td>DETROIT FREE PRESS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>581</td>
<td>AGRIBUSINESS U.S.A.</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>583</td>
<td>INFOMAT INTERNATIONAL BUSINESS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>603</td>
<td>NEWSPAPER ABSTRACTS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>609</td>
<td>KNIGHT-RIDDER/TRIBUNE BUSINESS NEWS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>610</td>
<td>BUSINESSWIRE</td>
<td>Newspaper</td>
</tr>
<tr>
<td>615</td>
<td>AGENCE FRANCE PRESSE INTERNATIONAL</td>
<td>Newspaper</td>
</tr>
<tr>
<td>630</td>
<td>LOS ANGELES TIMES</td>
<td>Newspaper</td>
</tr>
<tr>
<td>Database</td>
<td>Description</td>
<td>ProCite Workform</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>631</td>
<td>BOSTON GLOBE</td>
<td>Newspaper</td>
</tr>
<tr>
<td>632</td>
<td>CHICAGO TRIBUNE</td>
<td>Newspaper</td>
</tr>
<tr>
<td>633</td>
<td>PHILADELPHIA INQUIRER</td>
<td>Newspaper</td>
</tr>
<tr>
<td>636</td>
<td>PTS NEWSLETTER DATABASE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>638</td>
<td>NEWSDAY and NEW YORK NEWSDAY</td>
<td>Newspaper</td>
</tr>
<tr>
<td>640</td>
<td>SAN FRANCISCO CHRONICLE</td>
<td>Newspaper</td>
</tr>
<tr>
<td>647</td>
<td>MAGAZINE ASAP</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>648</td>
<td>TRADE AND INDUSTRY ASAP</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>649</td>
<td>NEWSWIRE ASAP</td>
<td>Newspaper</td>
</tr>
<tr>
<td>669</td>
<td>FEDERAL REGISTER</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>675</td>
<td>COMPUTER ASAP</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>703</td>
<td>USA TODAY</td>
<td>Newspaper</td>
</tr>
<tr>
<td>710</td>
<td>TIMES/SUNDAY TIMES (LONDON)</td>
<td>Newspaper</td>
</tr>
<tr>
<td>711</td>
<td>INDEPENDENT (LONDON)</td>
<td>Newspaper</td>
</tr>
<tr>
<td>715</td>
<td>CHRISTIAN SCIENCE MONITOR</td>
<td>Newspaper</td>
</tr>
<tr>
<td>716</td>
<td>DAILY NEWS OF LOS ANGELES</td>
<td>Newspaper</td>
</tr>
<tr>
<td>717</td>
<td>WASHINGTON TIMES</td>
<td>Newspaper</td>
</tr>
<tr>
<td>731</td>
<td>PHILADELPHIA DAILY NEWS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>772</td>
<td>TEXTLINE: UNITED KINGDOM NEWS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>773</td>
<td>TEXTLINE: EUROPEAN NEWS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>774</td>
<td>TEXTLINE: NORTH/CENTRAL/SOUTH AMERI</td>
<td>Newspaper</td>
</tr>
<tr>
<td>775</td>
<td>TEXTLINE: MIDEAST/AFRICAN NEWS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>776</td>
<td>TEXTLINE: ASIAN/AUSTRALIAN NEWS</td>
<td>Newspaper</td>
</tr>
<tr>
<td>777</td>
<td>TEXTLINE: WORLDWIDE JOURNALS</td>
<td>Newspaper</td>
</tr>
</tbody>
</table>
## MEDLARS (National Library of Medicine)

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIDSLINE</td>
<td>AIDSLINE</td>
<td>Conference Proceedings</td>
</tr>
<tr>
<td>AVLINE</td>
<td>AVLINE: Audiovisual Online</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>BACK75</td>
<td>BACK75: MEDLINE (1975-1979)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BACK77</td>
<td>BACK77: MEDLINE (1975-1979)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BACK90</td>
<td>BACK90: MEDLINE (1990-1993)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOETHICS</td>
<td>BIOETHICSLINE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOTECHSEEK</td>
<td>Biotechseek</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CANCERLINE</td>
<td>CANCERLINE (CANCERLIT)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CANCERLIT</td>
<td>CANCERLIT</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CATLINE</td>
<td>NLM CATALOG ONLINE</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>HEALTH</td>
<td>HEALTH PLANNING AND ADMINISTRATION</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>HISTORY</td>
<td>HISTORY OF MEDICINE ONLINE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MED75</td>
<td>MED75: MEDLINE (1975-1979)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>POPLINE</td>
<td>POPULATION INFORMATION ONLINE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>SDILINE</td>
<td>SDILINE: MEDLINE: MEDLINE: CURRENT FULL MONTH</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TOXLINE</td>
<td>TOXICOLOGY LITERATURE ONLINE (1981- )</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TOXLINE65</td>
<td>TOXICOLOGY LITERATURE ONLINE (-1980)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TOXLIT</td>
<td>TOXICOLOGY LITERATURE FROM SPECIAL SOURCES (1981-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TOXLIT65</td>
<td>TOXICOLOGY LITERATURE FROM SPECIAL SOURCES (-1980)</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>
### Melvyl

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABI/INFORM</td>
<td>ABI/Inform Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>COMP</td>
<td>IAC's Computer Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CURRENT CONTENT</td>
<td>Current Contents Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>INSPEC</td>
<td>INSPEC Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MAGS</td>
<td>IAC's Expanded Academic Index</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MEDLINE</td>
<td>MEDLINE Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MONOGRAPHS</td>
<td>UC Monographs Database</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>NEWS</td>
<td>IAC's National Newspaper Index</td>
<td>Newspaper</td>
</tr>
<tr>
<td>PERIODICALS</td>
<td>UC Periodicals Database</td>
<td>Journal Whole</td>
</tr>
<tr>
<td>PSYCHINFO</td>
<td>Psychnfo Database</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>

### OVID Online

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>AARP</td>
<td>AgeLine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>AGRI</td>
<td>Current Contents: Agriculture, Biology &amp; Envir</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>AIDS</td>
<td>AidsLine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ARTS</td>
<td>Current Contents: Arts &amp; Humanities</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BBIP</td>
<td>Books in Print</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>BEHA</td>
<td>Current Contents: Social &amp; Behavioral Science</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOE</td>
<td>Bioethicsline</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOL</td>
<td>BIOSIS (1978 to Date)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOZ</td>
<td>BIOSIS (1970 to Date)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CANR</td>
<td>CancerLit</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CCML</td>
<td>Comprehensive Core Medical Library</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CCON</td>
<td>Current Contents Online</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CDEX</td>
<td>Compendex Plus</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CHID</td>
<td>Combined Health Information Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CHIR</td>
<td>Chirolers</td>
<td>Journal Short Form</td>
</tr>
<tr>
<td>CLIN</td>
<td>Current Contents: Clinical Medicine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CTOC</td>
<td>Current Contents Search</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>DISS</td>
<td>Dissertation Abstracts Online</td>
<td>Dissertation</td>
</tr>
<tr>
<td>EMED</td>
<td>Excerpta Medica (1988 to Present)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EPIL</td>
<td>National Epilepsy Library Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ERIC</td>
<td>ERIC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ETOH</td>
<td>Alcohol &amp; Alcohol Problems Science Databas</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>HLTH</td>
<td>Health Planning and Administration</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>INFO</td>
<td>ABI/INFORM</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>
### Database Description ProCite Workform

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>IPAB</td>
<td>International Pharmaceutical Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>LIFE</td>
<td>Current Contents: Life Sciences</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MESH</td>
<td>Medline (1986-present)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>NAHL</td>
<td>Nursing &amp; Allied Health</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>NTIS</td>
<td>National Technical Information Service</td>
<td>Report</td>
</tr>
<tr>
<td>PHAR</td>
<td>Pharmaprojects Current</td>
<td>Data File</td>
</tr>
<tr>
<td>PHYS</td>
<td>Current Contents: Physical, Chemical &amp; Earth</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYC</td>
<td>PsycINFO</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>REFU</td>
<td>Reference Update</td>
<td>Journal Short Form</td>
</tr>
<tr>
<td>SOCA</td>
<td>Sociological Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TECH</td>
<td>Current Contents: Engineering, Tech &amp; Appie</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WAST</td>
<td>Wilson Applied Science &amp; Technology Index</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WBAI</td>
<td>Wilson Biological &amp; Agricultural Index</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WGSI</td>
<td>Wilson General Science Index</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WHUM</td>
<td>Wilson Humanities Index</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WRGA</td>
<td>Wilson Readers Guide Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WSSI</td>
<td>Wilson Social Sciences Index</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>

---

### OVID OVID

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIDSLINE</td>
<td>AIDSLine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOETHICSLINE</td>
<td>BioethicsLine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOLOGICAL ABSTRACTS</td>
<td>Biological Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOSIS PREVIEWS</td>
<td>BIOSIS Previews</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CANCERLIT</td>
<td>CancerLit</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CINAHL</td>
<td>Nursing and Allied Health</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CLINPSYC</td>
<td>ClinPSYC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EMBASE95</td>
<td>Embase: Drugs &amp; Pharmacology (1995-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EMED94</td>
<td>Embase (1994-)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ERIC</td>
<td>Eric</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>HEALTH</td>
<td>Health Planning and Administration</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>IPA</td>
<td>International Pharmaceutical Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MDX</td>
<td>MDX Health Digest</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MEDLINE</td>
<td>Medline</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>
### Appendix D: Configuration Files

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEJM</td>
<td>New England Journal of Medicine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PHENYTOIN</td>
<td>Phenytoin Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYCINFO</td>
<td>PsycINFO</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYCLIT</td>
<td>PsycLit</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WILSON</td>
<td>Wilson Business Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BUSINESS ABSTRACTS</td>
<td>Wilson Business Abstracts</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>

### OVID Reprint

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIDSLINE</td>
<td>AIDSLine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOETHICSLINE</td>
<td>BioethicsLine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOLOGICAL ABSTRACTS</td>
<td>Biological Abstracts (BIOSIS)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOSIS PREVIEWS</td>
<td>BIOSIS Previews</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CANCERLIT</td>
<td>CancerLit</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CINAHL</td>
<td>Nursing and Allied Health</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CLINPSYC</td>
<td>ClinPSYC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EMBASE: DRUGS &amp; PHARM</td>
<td>Embase: Drugs and Pharmacology</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ERIC</td>
<td>ERIC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>HEALTH</td>
<td>Health Planning and Administration</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>IPA</td>
<td>International Pharmaceutical Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MDX</td>
<td>MDX Health Digest</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MEDLINE</td>
<td>Medline</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PHENYTOIN</td>
<td>Phenytoin Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYCHINFO</td>
<td>PsychINFO</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYCLIT</td>
<td>PsycLit</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WILSON</td>
<td>Wilson Business Abstracts</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>
## PROQUEST

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABI/INFORM GLOBAL</td>
<td>ABI/Inform Global Edition</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ABI/INFORM SELECT</td>
<td>ABI/Inform Select Edition</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ACCOUNTING &amp; TAX</td>
<td>Accounting &amp; Tax Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>DISSERTATION - SCIENCES</td>
<td>Dissertation Abstracts - Sciences &amp; Engin.</td>
<td>Dissertation</td>
</tr>
<tr>
<td>DISSERTATION ABSTRACTS</td>
<td>Dissertation Abstracts</td>
<td>Dissertation</td>
</tr>
<tr>
<td>PERIODICAL ABSTRACTS - SELECT</td>
<td>Periodical Abstracts Select Edition</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>

## PROQUEST 2

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>NEWSPAPER ABSTRACTS</td>
<td>Newspaper Abstracts</td>
<td>Newspaper</td>
</tr>
<tr>
<td>NEWSPAPER ABSTRACTS - NATIONAL</td>
<td>Newspaper Abstracts - National</td>
<td>Newspaper</td>
</tr>
<tr>
<td>RESOURCE/ONE</td>
<td>Resource/One</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>RESOURCE/ONE SELECT</td>
<td>Resource/One Select</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>Database</td>
<td>Description</td>
<td>ProCite Workform</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>A-V ONLINE</td>
<td>A-V ONLINE</td>
<td>Audiovisual Material</td>
</tr>
<tr>
<td>AGRICOLA</td>
<td>AGRICOLA</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>AGRIS</td>
<td>AGRIS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>AIDS LINE</td>
<td>AIDS LINE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ANALYTICAL</td>
<td>Analytical Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ANESTHESIOLOGY</td>
<td>Excerpta Medica - Anesthesiology</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BA ON CD</td>
<td>Biological Abstracts on CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BA/RRM ON CD</td>
<td>Biological Abstracts/RRM on CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BEASTCD</td>
<td>BEASTCD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOTECH</td>
<td>Biotechnology Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CAB ABSTRACTS</td>
<td>CAB ABSTRACTS Database on CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CABPESTCD</td>
<td>CABPESTCD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CANCER-CD</td>
<td>CANCER-CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CARDIOLOGY</td>
<td>Excerpta Medica - Cardiology</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CINAHL</td>
<td>Nursing &amp; Allied Health (CINAHL)-CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CLINPSYC</td>
<td>ClinPSYC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>COMPUTER LIBRARY</td>
<td>OCLC Computer Library</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>Cross Cultural</td>
<td>Cross-Cultural CD</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>Death and Dying</td>
<td>Cross-Cultural CD - Death and Dying</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>DRUGS &amp; PHARMACOLOGY</td>
<td>1/95-7/95 Excerpta Medica - Drugs and Pharmacology</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ECONLIT</td>
<td>EconLit</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EDUCATION LIBRARY</td>
<td>OCLC Education Library</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>EMBASE ALERT CD</td>
<td>EMBASE Alert CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EMBASE CD</td>
<td>EMBASE CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ENVIRONMENTAL LIBRARY</td>
<td>OCLC Environmental Library</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>ERIC</td>
<td>ERIC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ETDE</td>
<td>ETDE Energy Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EXCERPTA MEDICA</td>
<td>Excerpta Medica Library Service</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>F&amp;S INDEX</td>
<td>F&amp;S INDEX plus TEXT</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>FOOD &amp; HUMAN NUTRITION</td>
<td>Food and Human Nutrition in AGRIS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>FOODS INTELLIGENCE</td>
<td>Foods Intelligence on Compact Disc</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>FSTA</td>
<td>FSTA on CD-ROM</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>GASTROENTEROLOGY</td>
<td>Excerpta Medica - Gastroenterology</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>GEOREF</td>
<td>GeoRef</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>GPO</td>
<td>GPO on SilverPlatter</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>HEALTHPLAN</td>
<td>HealthPLAN-CD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>HORTCD</td>
<td>HORTCD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ICONDA</td>
<td>ICONDA</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>IMMUNOLOGY &amp; AIDS</td>
<td>Excerpta Medica - Immunology and AIDS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>Database</td>
<td>Description</td>
<td>ProCite Workform</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------------------------------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>INIS</td>
<td>INIS on SilverPlatter</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>IPA</td>
<td>International Pharmaceutical Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ISA</td>
<td>Information Science Abstracts Plus</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ISA ERIC</td>
<td>Information Science Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>LIFE SCIENCES COLLECTION</td>
<td>Life Sciences Collection</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MDX</td>
<td>MDX Health Digest</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MEDLINE</td>
<td>MEDLINE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MLA</td>
<td>MLA International Bibliography</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MUSIC</td>
<td>OCLC Music Library</td>
<td>Sound Recording</td>
</tr>
<tr>
<td>NEPHROLOGY</td>
<td>Excerpta Medica - Nephrology</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>NEUROSCIENCES</td>
<td>Excerpta Medica - Neurosciences</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>NTIS</td>
<td>NTIS</td>
<td>Report</td>
</tr>
<tr>
<td>OBSTETRICS &amp; GYNECOLOGY</td>
<td>Excerpta Medica</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>Old Age</td>
<td>Cross-Cultural CD - Old Age</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>PAIS</td>
<td>PAIS International</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PATHOLOGY</td>
<td>Excerpta Medica - Pathology</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>POPLINE</td>
<td>POPLINE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYCHIATRY</td>
<td>Excerpta Medica - Psychiatry</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYCLIT</td>
<td>PsycLIT</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>PSYNDEX</td>
<td>PSYNDEX</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>RADIOLoGY</td>
<td>Excerpta Medica - Radiology and Nuclear Medicine</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>REFERENCE UPDATE</td>
<td>Reference Update on SilverPlatter</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>RINGDOC</td>
<td>RINGDOC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>SIGLE</td>
<td>SIGLE</td>
<td>Book Long Form</td>
</tr>
<tr>
<td>SOCIAL WORK</td>
<td>Social Work Abstracts Plus</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>SOCIOFILE</td>
<td>Sociofile</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>SPORT DISCUS</td>
<td>SPORT Discus</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TOXLINE</td>
<td>TOXLINE on SilverPlatter</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TOXLINE PLUS</td>
<td>TOXLINE PLUS on SilverPlatter</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TRECECD</td>
<td>TRECECD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>TROPAG</td>
<td>TROPAG &amp; RURAL</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>VETCD</td>
<td>VETCD</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WASTEINFO</td>
<td>WastelInfo</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WATER</td>
<td>Water Resources Abstracts on SilverPlatter</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>WATERLIT</td>
<td>WATERLIT</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>
### STN (4 tag area)

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANABSTR</td>
<td>Analytical Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOSIS</td>
<td>BIOSIS</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CEABA</td>
<td>Chemical Engineering and Biotechnical Abs</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>COMPENDEX</td>
<td>COMPENDEX</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CSNB</td>
<td>Chemical Safety News Base</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ICONDA</td>
<td>International Construction Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>INSPEC</td>
<td>INSPEC</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>MEDLINE</td>
<td>Medline</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>NTIS</td>
<td>National Technical Information Service</td>
<td>Report</td>
</tr>
</tbody>
</table>

### STN (5 tag area)

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABI-INFORM</td>
<td>ABI-Inform</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>APILIT2</td>
<td>American Petroleum Institute’s Literature db</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>APIPAT2</td>
<td>American Petroleum Institute’s Patent db</td>
<td>Patent</td>
</tr>
<tr>
<td>AQUASCI</td>
<td>Aquatic Sciences &amp; Fisheries Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BIOBUSINESS</td>
<td>Biobusiness</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>BLLDB</td>
<td>Bibliography of Linguistic Literature dB</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CA</td>
<td>Chemical Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CABA</td>
<td>CAB Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CEDB</td>
<td>Civil Engineering Database</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CERAB</td>
<td>Ceramic Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CIN</td>
<td>Chemical Industry Notes</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>COMPUAB</td>
<td>Computer and Information Science Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>CONF</td>
<td>Conferences in Energy, Physics, Math &amp; Chem</td>
<td>Conference Proceedings</td>
</tr>
<tr>
<td>CONFSCI</td>
<td>Conference Papers Index</td>
<td>Conference Proceedings</td>
</tr>
<tr>
<td>DISSABS</td>
<td>Dissertation Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ELCOM</td>
<td>Electronics &amp; Communications Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EMBASE</td>
<td>EMBASE</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>FSTA</td>
<td>Food Science and Technology Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>GEOREF</td>
<td>GeoRef</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ISMEC</td>
<td>Mechanical Engineering Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>LIFESCI</td>
<td>Life Science Collection</td>
<td>Journal Long Form</td>
</tr>
</tbody>
</table>
### STN (6 tag area)

<table>
<thead>
<tr>
<th>Database</th>
<th>Description</th>
<th>ProCite Workform</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBNB</td>
<td>Chemical Business Newsbank</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>COMPUSCIENCE</td>
<td>Compuscience</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>DDFU</td>
<td>Derwent Drug File (RINGDOC)</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>EMA</td>
<td>Engineered Materials Abstracts</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ENERGIE</td>
<td>Energie</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>ENERGY</td>
<td>Energy</td>
<td>Journal Long Form</td>
</tr>
<tr>
<td>INPADOC</td>
<td>International Patent Documentation Center</td>
<td>Patent</td>
</tr>
<tr>
<td>SIGLE</td>
<td>System for Info on Grey Literature in Europe</td>
<td>Dissertation</td>
</tr>
</tbody>
</table>
Close Biblio-Link II 46
Close Configuration Files 46
Components, listed in parsing format 101
Compress Multiple Spaces 83
Configuration File
list of those supplied 147
Configuration Files
backing up 47
closing 46
copying 45
creating 44
deleting 47
file properties 46
list of those supplied 7
opening 45
printing settings 1 13–1 14
renaming 47
sharing 47
Context-Sensitive Help 8
Conventions, in manual 10
Copy
configuration files 45
database settings 69
field properties 89–90
Corporate Authors 89, 96
Create Configuration Files 44–47
Current Contents on CD
OVID records 136
Reprint records 137
D
Database
default 63–64
description 65
Database Identifiers, entering 54–56
Databases
adding and mapping 64–66
copying 69
deleting 70
locating in download file 54–56
modifying 67–68
setting author formats 91–94
source field settings 99–100
Delete
configuration files 47
database identifiers 55
databases 70
document types 76
field tags 90
Description of Database 65
Dialog
configuration file 148–160
Dialog Records 138
Document Type
field type 82
field type options 88–90
Document Types
adding 74–76
deleting 76
mapping to Workforms 74–76
multiple in a field 74
recognizing 72–74
Download Files
ASCII text 1 15–1 18, 135
examining 49–53
examples 135, 147
opening 1 15
viewing 49
Download Records 7–8
Downloading Tips 135, 147
Duplicate
configuration files 45
database settings 69
field tag definitions 89–90
A
Add
author field tags 95
databases 64–66
document types 74–76
field tags 77–89
null subfields 1 10
"parsed with subfields" tags 107–109
source field tags 103–104
subfield tags 109–1 10
ASCII Text Files 1 15–1 18, 135
Author Format
setting by database 91–94
Author Tags, adding 95
Authors
corporate authors 96
field type 82
field type options 89
B
Back Up Files 47
Biblio-Link II
exiting 46
installing 10
starting the program 43
what it does 7
C
Capitalize
by field 83
by system 60
Carriage Return Replacement 84–85
Case Conversion
by field 83
by system 60
Change
database identifiers 55
database settings 67–68
field identifiers 58–61
field tag settings 78
record identifiers 57–58
workform selection 67–68
Index

E
E-mail address, Technical Support 9
Empty Field String 59
Enter
  database identifiers 54–56
  field identifiers 58–61
  ignored strings 61–62
  record identifiers 57–58
Enter Identifiers 53–62
Errors While Importing 115
Examine a Download File 49–53
Examples
  download files 49–53, 135, 147
  source fields 97, 98
  tagged subfields 107
Exit Biblio-Link II 46
Extraneous Text, ignoring 61–62

F
Field Attributes 81–83
Field Identifiers
  entering 58–61
Field Tag Definitions
  copying 89–90
Field Tag Length 59
Field Tags
  adding 77–89
  adding and mapping subfields 109–110
  adding author tags 95–96
  adding source field tags 103–104
  deleting 90
  locating 58–61
  mapping to ProCite fields 77–89
Field Type
  parsed with subfields 108
Field Type Options 84–89
  author 89
  date 84
  document type 88–90
  literal stream 84
  Multi-text 85–90
  normal text 84–90
  parsed 86–90
  parsed with subfields 88–90
Field Types 81–83
  author 95
  document type 73
  parsed 104

G
Fields
  listed by Workform 119
  recognizing document types 72–74
  terminated by 58
File
  list of configuration files 147
File Properties 46
Find in Download File
  document types 72–74
  field tags 58–61
  new database 54–56
  record identifier 57

H
Header Format
  in record identifiers 57
Help
  online 8
  technical support 9
  troubleshooting 8–9, 115

I
Icon, Biblio-Link II 43
Identifiers, entering 53–62
Ignored Strings 61–62
Import into ProCite 7
Importing, into ProCite 40
Importing Problems 115
Indented Field Text 60
Information
  about a configuration file 46
  downloading 7–8
Install Biblio-Link II 10

K
Keyboard Equivalents 10
Keyword Options 85–90

L
Lessons, to learn Biblio-Link II 11
Line Continuation Options 60
Literal Stream
  field type 82
  field type options 84
Locate in Download File
  databases 54–56
  field tags 58–61
  new records 57–58
Lowercase
  by field 83
  by file 60

M
Manual, style conventions 10
Map
  databases to workforms 64–66, 71–72
  document types to Workforms 74–76
  field tags 77–89
  subfield tags 109–110
MEDLARS, configuration file 152–160
Medlars Records 139
Melvyl, configuration file 153–160
Melvyl Records 140
Modify
  database identifiers 55
  database settings 67–68
  field tag settings 78
Multi-Text
  field type 81
  field type options 85–90
Multiple Document Types in a single field 74

N
New
  configuration file 44
  databases 64–66
  document types 74–76
  field tags 77–89
New Field Identifiers 58–61
New Record Identifiers 57–58
NLM, configuration file 152–160
Normal Text
  field type 81
  field type options 84–90
Null Subfields 110

O
Online Help 8
Open Configuration Files 45
Optional Parsing Components 102
Options for Field Types 84–89

OVID
  online records 141
  OVID records 142
  reprint records 143
OVID Online, configuration file 153–160
OVID OVID, configuration file 154–160

P

Parse Tagged Subfields 107
Parsed
  field type 81, 104
  field type options 86–90
Parsed Source Field
  adding field tag 103–104
  optional components 102
  punctuation 102
Parsed with Subfields
  field type 82
  field type options 88–90
Prefix, new database 55
Print Configuration File Settings 113–114
Print Report 113
ProCite Fields
  by workform 119
  mapping tags 79
ProCite, importing records 40
ProCite Workforms 119
Proquest 2, configuration file 156–160
Proquest, configuration file 156–160
ProQuest Records 144
Punctuation, in parsed source field 102

Q

Quit Biblio-Link II 46

R

Record Identifiers, entering 57–58
Record Transfer 7
Record Transfer to ProCite 40
Rename Configuration Files 47
Reports, printing settings 113–114
ResearchSoft
  technical support 9

S

Sample Download Files 135, 147
Select Workforms for Databases 71–72
Set a Parsing Format by Database 97–103
Set Field Attributes 81–83
Settings, printing to disk 113–114
Share Configuration Files 47
SilverPlatter, configuration file 157–160
SilverPlatter Records 145
Source Field
  adding field tag 103–104
  field options 86–90
  target ProCite fields 86–90
Spaces, compressing multiple 83
SPIRS, configuration file 157–160
Start Biblio-Link II 43
STN 4, configuration file 159–160
STN 5, configuration file 159–160
STN 6, configuration file 160
STN Records 146
Subfield Examples 107
Subfield Tags, adding and mapping 109–110
Suffix, new database 55
Support, contacting the help desk 9

T

Tag Format 59
Tag Length 59
Tag Settings, copying 89–90
Tags
  adding and mapping 77–89
  deleting 90
Target Fields
  by Workform 79–81
  for source field 86–90
Technical Support 9
Terminate Fields 58
Toolbar Icons 10
Tour of Biblio-Link II 11
Transferring Records into ProCite 7, 40
Troubleshooting 8–9, 115
Tutorial 11

U

Uppercase
  by field 83
  by system 60

V

View Download Files 49

W

Workforms
  assigning to databases 65
  list of those supplied 119
  selecting by database 71–72
  selecting by document type 74–76